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About This User’s Guide

WARNING! Do not attempt to use this analyzer without first reading and 
understanding the entire User’s Guide! �

CAUTION NITON Analyzers are not intrinsically safe analyzers in regard to 
sparking. All pertinent Hot Work procedures should be followed in areas of 
concern. �

Unpacking and
Assembling Your

NITON XRF Analyzer

• Inspect the shipping carton for signs of damage such as crushed or water 
damaged packaging. Immediately notify the shipping company and 
Thermo Fisher Scientific, in the United States, toll free, at (800) 
875-1578, or outside the United States, at +1-978-670-7460, if there is 
any visible damage to the shipping container or any of its contents. 

• Open the packing carton. If your analyzer is not packed in its carrying 
case, please call Thermo Fisher Scientific immediately, in the United 
States, toll free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460.

• Verify the contents of the shipping container against the enclosed 
packing list. If there are any discrepancies between the actual contents of 
the shipping container and the enclosed packing list, please notify 
Thermo Fisher Scientific immediately, in the United States, toll free, at 
(800) 875-1578, or outside the United States, at +1-978-670-7460.

• Open the carrying case and visually inspect the analyzer for damage 
before removing it from the case. Call the shipper and Thermo Fisher 
Scientific if you find any damage to the case or its contents.

• Save the shipping carton and all packing materials. Store them in a safe, 
dry area for reuse the next time that you ship the analyzer. 
Thermo Scientific NITON XL3 Analyzer User’s Guide i



The NITON XRF
Analyzer Overview

The NITON XL3 Analyzer is a single unit, hand held, high performance 
portable x-ray fluorescence (XRF) elemental analyzer.

Figure 0-1. Analyzer Overview

The Control Panel The control panel is located on the analyzer’s top housing, directly below the 
LCD touch screen (see Figure 0-1). The control panel consists of a 4 way 
touch pad, a center button, and two control buttons, one on each side. 
Using either the control panel or the touch screen you may navigate through 
all of the analyzer’s screens and menus. You can control the movement of the 
screen cursor by pressing the four way control pad in one of four directions 
to highlight each of the menu options. The Select button in the center of 
the four way touch pad is used to select highlighted menu options. The 
on/off/escape button both controls the power to the analyzer and serves as 
an "escape" button. When the on/off/escape button is pushed and 
immediately released, it functions as an "escape", and brings you back to the 
Main Menu from the current screen in the menu system.

Top View 

Rear View Front View 

Control panel

LED lights Trigger

LCD touch screen

Kapton 
Measurement 
Window

Proximity Sensor

Rear
Interlock

Battery Pack/Han-
dle

Side View 
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Figure 0-2. The Control Panel

Push and hold the on/off/escape button for at least 3 seconds to turn the 
analyzer on.Push the on/off/escape button and hold it down for about 10 
seconds to shut off power to the analyzer from any screen in the menu 
system.

You also have the option of operating the analyzer, including navigating the 
menu system, by using the built in touch screen. To select a menu option, 
tap on the icon once. The touch screen icons have the same functionality as 
the four way touch pad, the on/off/escape button, and the select or enter 
button. This User's Guide will refer to the process of choosing a course of 
action by selecting an icon from a menu, either using the touch screen or 
using the control panel buttons, as “selecting.”

Selecting the Return icon works everywhere throughout the User Interface 
to bring you back to the previous menu from the current menu in the menu 
system. Use the on/off/escape button to return to the Main Menu.

LCD touch 
screen

On/off/escape 
button

Clear/enter 
button

4-way touch padInterlock button

Select button

LCD touch 
screen catch
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The LCD Touch Screen
The LCD Touch
Screen

The LCD Touch Screen on your XL3 Analyzer is designed to swing up and 
down to different angles for ease in viewing and interacting with your 
analyzer. The LCD Touch Screen is connected to your analyzer along the 
base of the screen, right above the Control panel. The screen is not designed 
to separate from the analyzer, but can be adjusted to any arbitrary angle 
between zero degrees - that is, flush with the analyzer - and 85 degrees, 
which is almost perpendicular. The LCD Touch Screen will stay at any 
given angle between these extremes until moved to a different angle. When 
in closed position, the screen is secured by a catch at the top center of the 
screen housing.

Figure 0-3. XL3 Analyzer Showing LCD Screen Tilted.

• To raise the LCD Touch Screen, disengage the catch at the top-center of 
the LCD Touch Screen housing and gently pull the screen towards you 
until it is at the best angle for your use. 

• To close the LCD Touch Screen, gently push away from you along the 
top edge of the screen housing. The screen will swing down until the 
catch solidly engages with an audible click.

Note The LCD Touch Screen cannot be removed from your XL3 analyzer. 
Removing or attempting to remove the LCD Touch Screen will damage 
your analyzer and void your warranty.

Note Always close your LCD Touch Screen before storing or transporting 
your XL3 analyzer.
iv NITON XL3 Analyzer User’s Guide Thermo Scientific



The Data Ports
The Data Ports

Figure 0-4. Data Ports on the XL3

USB Port The USB Port is a communications and control port, for uploading and 
downloading data, configuration files, and software to the analyzer.

Remote Trigger Port The Remote Trigger Port controls the analyzer’s trigger function, for use 
with the Extend-a-pole, In Situ Tripod, and test stands.

Serial Port The Serial Port is a communications and control port, for uploading and 
downloading data, configuration files, and software to the analyzer.

Power Port The power port is used to run the XL3 under external power.

Power Port

Serial Port
Remote Trigger Port

USB Port
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The Data Ports
Instrument Startup To turn on the analyzer, depress the on/off/escape button on the control 
panel for approximately 10 seconds.

Figure 0-5. System Start Screen

On startup, the screen will be replaced by a Start Screen (see Figure 0-5) 
which will automatically count down from 9 to 0 in increments of one 
second.      

Figure 0-6. Logon Screen

When the Start is complete, the Start Screen will be replaced by the Logon 
screen (see Figure 0-6.) Tap anywhere on this screen to continue.

The Logon Screen will be replaced by a Warning Screen, see Figure 0-7, 
advising you that this analyzer produces radiation when the lights are 
flashing. You must acknowledge this warning by selecting the “Yes” button 
before logging on. Selecting the “No” button will return you to the Logon 
Screen.
vi NITON XL3 Analyzer User’s Guide Thermo Scientific



The Data Ports
Figure 0-7. Warning Screen

After selecting the “Yes” button, the Virtual Numeric Keypad becomes 
available for you to log onto the analyzer.

Figure 0-8. Virtual Numeric Keypad for Logon
Thermo Scientific NITON XL3 Analyzer User’s Guide vii



The Data Ports
Select your 4 digit security code, followed by the enter (E) key. The 
temporary password assigned by default is 1-2-3-4, followed by the “E” key. 
If you enter an incorrect number, you can use the “<“ key to backspace over 
it, ot use the “C” key to clear everything. After you have completed the log 
on procedure, the word "USER" will appear on the bottom of the screen, 
then the Main Menu will appear. Note that security codes are editable. 
Please see the NDT manual for instructions on creating user-definable 
passwords.

Check the date/time. The time should be set correctly for accurate and 
verifiable record keeping (See Chapter  1 page 92). 

Your analyzer can be stored and operated safely in temperatures from -10º C 
(14º F) to 50º C (122º F). You will not be able to take a measurement if the 
analyzer overheats. If it is hot to the touch, you should allow it to cool 
before testing.

The NAV Menu

Figure 0-9. The NAV Menu

The Navigation Menu, or NAV Menu, is available in all screens, though 
only through the touch screen interface. Within a menu, the particular 
options available from the NAV Menu may change with the context. For 
example, within the View Menu, the NAV Menu changes options 
depending on the mode you are currently using.
viii NITON XL3 Analyzer User’s Guide Thermo Scientific



The Data Ports
Access the NAV Menu by selecting the word NAV in the screen. A 
drop-down menu of choices will appear. Selecting an option from the NAV 
Menu will take you directly to a particular menu, no matter where you are 
in the menu hierarchy. Selecting the “View” option from the NAV Menu, 
for example, will bring you directly to the Data Menu.

The NAV Menu cannot be selected through the Control Panel.

The Battery Life Indicator The Battery Life Indicator is visible on all screens in the menu system. The 
indicator is visible in the top right portion of the screen, and graphically 
shows you how much battery life is left, enabling you to change batteries as 
needed to avoid unexpected shutdowns.

Figure 0-10. Battery Life Indicator

The more green visible in the indicator, the higher the charge. The more red 
visible in the indicator, the lower the charge. It’s best to charge one battery 
while using the other, to avoid work slowdowns or stoppages due to battery 
charge conditions.

WARNING! In the highly unlikely event that the x-ray tube remains on 
when the trigger is not depressed, disconnect the battery pack immediately 
to turn off the x-ray tube, and call Thermo Fisher Scientific’s Service 
Department in the United States, toll free, at (800) 875-1578, or outside 
the United States at +1-978-670-7460, or your local Authorized NITON 
Analyzers Service Center. �

Battery Life Indicator

External Power Source

Full Battery
90% Battery Life
75% Battery Life

50% Battery Life

25% Battery Life
05% Battery Life

Battery Life Key
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The Data Ports
The Menu Path The Menu Path shows you graphically how to get to the function being 
described in several discrete steps from the universal start position, the Main 
Menu.  

Figure 0-11. Example Menu Path

In the Menu Path, the order is top to bottom, then if needed left to right, 
starting with the Main Menu and ending with the function wanted. The 
arrows show the succession of menus, while the icon to be selected is 
highlighted by a heavy rectangular border.

This Menu path should be read as:

To get to this screen, starting at the Main Menu, select the Mode icon, 
select the Alloy icon, select the Chemistry icon, then select the All Alloys 
icon.
x NITON XL3 Analyzer User’s Guide Thermo Scientific



Applications
The NAV Menu
Chapter 1 Applications

The NAV Menu The NAV Menu enables you to move between various menus and screens 
directly, without going through the intervening screens. Select a destination 
from the drop down menu and you will be brought directly to that menu or 
screen.

Figure 1-1. The NAV Menu
Thermo Scientific NITON XL3 Analyzer User’s Guide 1-1



Applications
The Tools Menu
The Tools Menu The Tools Menu enables you to perform common data-related tasks such as 
printing and averaging. Select a task from the drop down menu to initiate 
that task.

.

Figure 1-2. The Tools Menu

The Tools Menu, like the NAV Menu, uses context sensitive menus. The 
following is the most common menu set.

Print Enables you to print the sample analysis to the optional printer.

Backlight Enables you to turn backlighting on and off.

Avg Forward Enables you to average different readings together from this analysis 
forward. Select Avg Forward to initiate future sample averaging. Avg 
Forward will set up an automatic personal averaging protocol to be followed 
until your analyzer is shut down, or this feature is disabled. To begin, select 
the number of readings you want to average from the virtual numeric 
keypad. Your analyzer will calculate an average reading after that number of 
tests, and continue this pattern until stopped. For example, if you select 3 
on the virtual keypad, the analyzer will automatically calculate, average, and 
store a reading for every three tests you take, storing the individual readings 
along the way.
1-2 NITON XL3 Analyzer User’s Guide Thermo Scientific



Applications
The Tools Menu
Avg Back Enables you to average different readings together from this analysis 
backward. Select Avg Back to initiate backwards sample averaging. Avg 
Back will take a number of readings you select and average their analytical 
results. The range is counted from the last reading backward by the number 
of readings selected. If your last reading was #15, selecting 3 would average 
readings #13, 14, and 15. The average is calculated, displayed, and stored 
into memory as the next sequential reading number.

The range number is selected using a virtual keypad on your analyzer similar 
to the keypad used for login. Select the digits in the range number from the 
keypad, then select the “E” key to enter the number. “C” will clear all, and 
“<“ will clear the last digit entered. The average will automatically be 
displayed.

Figure 1-3. The Virtual Numeric Keypad for Averaging

Note You cannot average readings taken with different element lists - or with 
different filter settings if the settings have different element lists - with either 
Avg Back or Avg Forward. Alloy and Mining modes each use the same 
element lists with the different filter settings, so averaging works when 
switching between filter settings when in either of these modes. Thin Film 
and Bulk modes both use different element lists for different filter settings, 
and readings with different filter settings cannot be averaged when using 
either of these modes. You can never average readings taken in different 
modes.�
Thermo Scientific NITON XL3 Analyzer User’s Guide 1-3



Applications
The Tools Menu
Note The Tools Menu is only available when viewing readings, and the 
menu is only accessible through the touch screen interface or NDTr. �

Stop Avg Fwd/Back Avg Back and Avg Forward are toggles. The option on the Tools Menu 
changes to its opposite when selected. To stop averaging, select Stop Avg 
Fwd or Stop Avg Back from the Tools Menu as appropriate.

Figure 1-4. The Tools Menu - Averaging Toggles
1-4 NITON XL3 Analyzer User’s Guide Thermo Scientific



Applications
Example Averaging
Example Averaging

Figure 1-5. Averaging example: 3 readings
Thermo Scientific NITON XL3 Analyzer User’s Guide 1-5



Applications
Live Spectrum Feed
Live Spectrum Feed The Tools Menu may contain a toggle option to display live spectra as 
sample analysis occurs. 

Figure 1-6. The Tools Menu showing the Spectra On/Off Toggle

Activating and
Deactivating the Live

Spectrum

From the Tools Menu, select Spectra : On to turn the Spectrun feed on. 
Once the spectrum is displayed, selecting Spectra : Off from the Tools Menu 
will stop the live spectrum display.

Figure 1-7. Test Screen Showing Live Spectrum
1-6 NITON XL3 Analyzer User’s Guide Thermo Scientific



RoHS Compliance
RoHS Compliance

RoHS Operating
Procedure

Please review the Standard Operating Procedures (SOP) included with your 
analyzer.  The SOP includes the most current instructions for RoHS and 
WEEE analysis with your NITON analyzer.

If you have had your analyzer for some time, the most recent RoHS 
Standard Operating Procedures for NITON analyers are available from 
Thermo Scientific upon request. For more information on this document, 
please contact Thermo Scientific’s Customer Service Department in the 
United States, Toll free, at (800) 875-1578, or outside the United States at + 
1-978-670-7460, or your authorized NITON Analyzer Service Center.

Figure 1-1. RoHS Testing Screens

Interpreting the symbols
on-screen.

a. An asterisk (e.g. Cd*) indicates that the element concentration 
minus the uncertainty is higher than the Fail limit. 

b. A question mark (e.g. Cd?) means that the element concentration in 
question is inconclusive, i.e. between the user-defined Pass and Fail 
limits.  (Please refer to the User Manual for instruction on changing 

#1 #2 #3

Inconclusive:

The results for Br, Hg, and 
Cr are not yet conclusive. 
Longer testing times may 
be needed.

Pass:

Compliant for all RoHS 
Elements. 

Note that low Fail limits 
may require longer 
testing times to establish 
compliance.

Fail:

Noncompliant levels of 
Cd.
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RoHS Compliance
pass/Fail Limits). In some cases, the question mark indicates that a 
longer analysis time is required to determine whether or not that 
element passes or fails the RoHS limits.  

c. An element symbol not denoted with either an asterisk or a question 
mark (e.g. Cd) means the concentration of the element plus the 
uncertainty is lower than the Pass limit.  Please refer to the chart on 
page ten for further information concerning Pass / Fail / 
Inconclusive results.

1. The results screen displays analytical results for detected (i.e. 
above detection limit) and non-detected (i.e. below detection 
limit) elements.  (See Measurement Time section for an 
explanation of statistical precision and detection limits.)  The five 
RoHS elements are always listed first on the screen, whether they 
have been detected or not.  Note that a RoHS element not 
detected above a reading's detection limit is listed as "ND < 
XXX" where XXX is the three standard deviation detection limit.  
A complete list of elements measured during a reading can be 
viewed by scrolling down the display using the down arrow 
button.  Refer to the release notes for instructions how to alter the 
element display screen.
1-8 NITON XL3 Analyzer User’s Guide Thermo Scientific



Plastics Analysis Mode
Plastics Analysis
Mode

Figure 1-2. Plastics Analysis Mode

The Plastics Analysis Mode is available from the Bulk Mode Menu.  
This mode alloys you to perform tests on plastics and electronics to 
determine their content of critical elements.  Your analyzer first determines 
whether the sample is PVC or non-PVC based material.  Because PVC's are 
much denser than non-PVC materials, your analyzer uses a different 
calibration model to ensure the most accurate results possible.

Select the Data Entry icon from the Plastics Analysis Mode Menu to 
prepare to initiate a sample measurement. Type the parameters of the sample 
directly into the instrument using the Virtual Keyboard. The parameters 
you choose will be attached to the results of the next Plastics Analysis 
Mode test you perform. 
Thermo Scientific NITON XL3 Analyzer User’s Guide 1-9



Thickness Correction
Thickness Correction Plastics, and polymers in general, unlike metals or soil, are very weak 
absorbers of X rays. This is because polymers are composed mainly of very 
light elements such as carbon and hydrogen. While just half a millimeter of 
steel will completely stop 23.1 keV energy X rays of cadmium, for example, 
it takes at least 10mm of plasticized PVC and as much as 100mm of 
polyethylene (PE) to do so. Fortunately, polymers that may contain 
cadmium (Cd), lead (Pb) and other restricted elements would also contain 
considerable quantity of elements such as antimony (Sb), bromine (Br), 
titanium (Ti), etc. Their presence results in much stronger absorption of X 
rays which means that, instead of 100mm, it takes only about 15mm of 
compounded PE to achieve saturation thickness for these X rays.

If the thickness of analyzed polymer sample is less than 5mm for PVC or less 
than about 9mm for a “typical” PE, the measured intensity of X rays will be 
a function of both analyte concentration and sample thickness. This is why 
measurements performed on thin samples (less than saturation thickness) 
need to be corrected for thickness.

How to apply Thickness
Correction.

In order for the instrument to apply thickness correction to the measured 
concentration results, the user must be using the Thickness Correction 
screen and enter the thickness of the analyzed plastic object expressed in 
[mm] before the measurement is initiated. The thickness may be entered 
with precision to the second decimal place, although in practice only one 
decimal place is sufficient for effective correction.
1-10 NITON XL3 Analyzer User’s Guide Thermo Scientific



Thickness Correction
Figure 1-3. How to enable and adjust Thickness Correction for Plastics 
Analysis

When to use Thickness
Correction

Thickness Correction should only be used during the analysis of plastic 
(polymer) objects. It has been experimentally verified that the correction 
algorithm will yield satisfactory results, for a 60 second minimum testing 
time, for samples as thin as 0.3mm. Nevertheless, the recommended range 
of use of the correction is from 1mm upwards. It is imperative that this 
correction is not used for thin films such as single foils and plastic 
membranes; analysis of thin films is performed using the Thin Sample 
Mode. (Contact Contact Thermo Scientific or your local NITON Analyzers 
representative for information on this testing mode.)

Whenever possible, one should analyze as thick a sample as available. For 
example, if the analyzed object is a piece of heatshrink tubing with wall 
thickness of 0.3mm, the best way to analyze it is to obtain several pieces of 
the tubing (four for example) and stack them like a flat sandwich, with the 
thickness correction set to 1.2mm. Doing so makes for faster and more 
precise analyses. While it would be possible to analyze just a single layer of 
the tubing with correction at 0.3 mm, by stacking several layers we reduce 
the relative error of measurement (by a factor approximately equal to the 
square root of the number of layers). Conversely, when analyzing thinner 
samples, we need to extend the measurement time fourfold (by the number 
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Thickness Correction
of layers) in order to maintain the same relative error of measurement. We 
can see how quickly measurement time would escalate to impractical levels 
for thinner samples.

Examples The most frequent instances in which thickness correction would be called 
for are analyses of plastic sheeting or plastic insulation on wires and/or 
cables and heat shrink tubing. Flat plastic sheeting or plastic enclosures pose 
no problems. We can either analyze an object “as is”, or stack several layers 
of it before analysis. Plastic insulation such as that on wiring or cables 
requires a little more sophisticated approach. First, the wire must be 
removed so that only insulation is analyzed. Then, the insulation should be 
flattened for analysis, and a thickness correction should be applied that is 
equal to double the wall thickness. Alternatively, if the insulation is stiff, it 
should be cut lengthwise into strands which are placed on the indtrument 
for analysis. The applied thickness correction should be equal to the wall 
thickness of the sleeve. Both operations are shown in Figure 1-4 and 
Figure 1-5.

Figure 1-4. Wire insulation cut into strands.
1-12 NITON XL3 Analyzer User’s Guide Thermo Scientific



Thickness Correction
Figure 1-5. PVC wire insulation with conductor removed

A piece of large diameter heat shrink tubing presents an interesting case. It is 
tempting to analyze this object as is - see Figure 1-6. However, one needs to 
know that while lead or bromine or chromium X-rays from the upper wall 
of tubing will not contribute to the signal measured, X rays of such elements 
as cadmium, antimony, tin or barium in the upper wall will significantly 
contribute to overall signal. It is therefore imperative to either flatten the 
tubing for analysis or cut it in pieces and then analyze as shown in  
Figure 1-7.

Figure 1-6. Incorrect Way to Measure Heat Shrink Tubing
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Thickness Correction
Figure 1-7. Correct Way to Measure Heat Shrink Tubing

WARNING!  Thickness correction is only for use with plastic/polymer 
samples.
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Analyzing Bulk Samples
Analyzing Bulk
Samples

CAUTION Whenever you turn on your NITON Analyzer after it has been 
off for more than 30 minutes, you should measure your check sample to 
assure proper operation. If the instrument is not reading properly, you 
should re-calibrate your NITON Analyzer's sample analysis electronics 
before you start to take readings. When the instrument is turned on after 
being off for more than 30 minutes, your NITON analyzer will require a 10 
minute warm-up period before the instrument can be calibrated, unless this 
10 minute warm-up period is manually overridden.

There are seven different methods of operation for taking a sample 
measurement, and your analyzer will be configured to use one of those 
methods for soil samples, depending on the regulatory requirements of your 
locality. These methods are:

• Trigger-Only method. With the Trigger-Only method, you only need to 
place the measurement window close to the sample to be analyzed and 
pull the trigger for sample analysis to be initiated. 

• Trigger-and-Proximity-Sensor method. With the 
Trigger-and-Proximity-Sensor method, you must place the measurement 
window against the sample to be analyzed to engage the proximity 
sensor on the front of the instrument, then pull the trigger for sample 
analysis to be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With the 
Momentary-Trigger-Touch-and-Proximity-Sensor method, you must 
place the measurement window against the surface to be analyzed to 
engage the proximity sensor on the front of the instrument, then pull 
the trigger.

• The trigger may be released and the reading will continue until you 
release the proximity button, or other criteria (such as Max Time) are 
reached.

• Trigger-and-Interlock method. With the Trigger-and-Interlock method, 
you need to place the measurement window close to the sample to be 
analyzed, press and keep pressing the interlock button at the rear of the 
instrument with your free hand, then pull the trigger for sample analysis 
to be initiated.
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Analyzing Bulk Samples
• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage the 
proximity sensor on the front of the instrument, press and keep pressing 
the interlock button at the rear of the instrument with your free hand, 
then pull the trigger for sample analysis to be initiated.

• Easy Trigger method. With the Easy trigger method, you need only 
place the measurement window against the sample area and pull the 
trigger once to initiate a sample analysis. Your analyzer will continuously 
sample the backscatter, using a complex internal algorithm, to 
determine if the measurement window is against a sample or pointing to 
the empty air. If it finds that there is no sample directly against the 
measurement window, the analyzer will stop directing radiation through 
the window as soon as this determination is made.

Note The analyzer is constantly checking the backscatter characteristics to 
determine if a sample is against the measurement window, whether or not 
the Easy Trigger method is being used, and will shut off any radiation 
directed through the window if it determines that there is no sample 
present.

With any of these methods, analysis will stop if any one of the preconditions 
are violated. For example, with the Trigger-Interlock-and-Proximity-Sensor 
method, if the trigger or the Proximity Sensor or the Interlock is released, 
the reading will stop immediately, and the shutters will close, and the X-ray 
tube will shut down.

After your NITON analyzer is calibrated, initiate a sample reading using the 
appropriate method. If you attempt to initiate a sample reading using a 
different method, the analyzer will inform you that one or more of the 
preconditions need to be met in order for sample analysis to begin. Initiate 
the proper preconditions for operation to turn on the x-ray tube, open the 
calibration shutter, and begin a measurement. Although the three LED 
lights will begin to flash as soon the initiating preconditions are met, as a 
safety precaution, the x-ray tube will not turn on immediately, and no 
reading will begin for approximately 0.5 seconds.

WARNING!  Do not attempt to take measurements while downloading 
readings! This will generate an error requiring a system reset, and may 
corrupt your stored readings, requiring all stored readings to be erased. �
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Analyzing Bulk Samples
WARNING!  When all four LED lights are blinking, the x-ray tube is on. 
This should only occur during a measurement, while the preconditions for 
operation are met. On startup, the front pair of lights will blink. If the LED 
lights blink at any other time, disconnect the battery pack and call Thermo 
Scientific’s Service Department in the United States, toll free, at (800) 
875-1578, or outside the United States, at +1-978-670-7460, or your local 
Authorized NITON Analyzer Service Center. �

To end the test, simply release the trigger mechanism, or any other 
applicable preconditions.

Note The four LED lights will blink whenever the x-ray tube is powered on 
and shutter opened.

Your NITON Analyzer will display the Results Screen throughout the 
duration of each reading, The Results Screen is updated regularly 
throughout the reading. When the reading is complete, a final screen update 
will appear, and your NITON analyzer will display the final results of the 
measurement which has just been completed.

Figure 1-8. The Plastics Mode Result Screen

Mode Line

Battery Charge
Indicator

Plastics Type
Column Head
/Buttons

Confidence ColumnConcentration Column
Element
Column

Reading Number
Tools MenuNAV Menu

Test Duration

Pass/Fail
Determi-
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The Results Screen displays the following information:

• The Reading Number line shows a number automatically assigned by 
your NITON analyzer in order to uniquely identify each reading. The 
reading number automatically increments up by one with each 
successive reading.

• The Mode line displays the mode cuurently in operation.

• The Plastics Type displays wether the plastic in the sample was found 
to be PVC or Non-PVC type.

• The Pass/Fail Determination ells at a clance whether the reading is in or 
out of compliance.

• The Test Duration line shows the number of nominal seconds elapsing 
since the initiation of the reading. Nominal seconds are true, clock 
seconds when the analyzer is taking a measurement. 

• The Battery Charge Indicator displays the current charge remaining 
in the battery.

• The Mode line displays the test mode in use during the measurement.

• The Element (left) column shows the elements that have been detected 
in the sample. 

• The Concentration Level (central) column shows the concentration 
levels of the corresponding elements in percentages.

• The Confidence (right) column displays the 2 sigma (95%) confidence 
interval for the corresponding elements.

The NAV Menu button allows you to access the NAV Menu

The Tools Menu button allows you to access the Tools Menu.

Testing Prepared Samples Set the NITON test platform on a flat, solid surface. Slide out the drawer 
and place the sample cup mylar side facing up in the holder and slide the 
drawer shut. Insert the instrument into the nose cone adaptor so that the 
LCD screen is facing in the same side as the test platform drawer and follow 
ex-situ bulk sample instructions
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The Data Entry Screen The Data Entry Screen is accessed whenever you select the Data Entry 
icon from any screen. This screen allows you to input data in several 
different fields, or categories, concerning your sample. These fields are saved 
along with the reading, and allow you to associate important information 
about the sample directly with the reading, so that you have a full 
description of the sample tied into the reading itself.

Once you have input data into a field, that information carries over into the 
next reading, so that you only have to input the information that has 
changed since the last reading. For example, if you are analyzing several 
samples of a particular lot, you only need to input the lot information once 
during that series of readings, changing only the sample name.

Data Entry Screens for
Plastics Mode

Figure 1-9. Data Entry Screen

This is the only section of the Data Entry Screen. There are five parameters 
in this section.

Selecting Sample allows you to input the sample name parameter

Selecting Location allows you to input the particular location information, 
if known

Selecting Inspector allows you to specify the inspector.

Virtual Keyboard
Button

Parameter Field 
Name

Drop-down List
Button

Parameter Field

Parameter Number
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The Data Entry Screen
Selecting Misc allows you to input miscellaneous parameters

Selecting Note allows you to input notes on the sample
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Navigating the Data Entry Screen
Navigating the Data
Entry Screen

Figure 1-10. The Control Panel

The following description of screen navigation using the control panel 
assumes that the analyzer is held so that the display is held upright as in 
Figure 1-10.

• To move from column to column, use the Right and Left portion of the 
4-way touch pad.

• To move from row to row, use the Up and Down portions of the 4-way 
touch pad.

• To select the highlighted option, press the Enter button on the control 
panel. 

The Data Entry Screen is divided into sections of 5 setting parameters. By 
using the Down portion of the 4-way touch pad when you are on the last 
row of a section, the display will change to the next section. By using the Up 
portion of the 4-way touch pad when you are on the first row of a section, 
the display will change to the previous section. 

By selecting the On/Off button, you can exit the Data Entry Screen.

Touch Screen 
Display

On/Off 
Button

Down

Right

4-way
 touch-pad

Up

Enter
Button

Left
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The Virtual Keyboard

Figure 1-11. Lower Case Virtual Keyboard

Figure 1-12. Upper Case Virtual Keyboard

The Virtual Keyboard is an alphanumeric keyboard which appears on the 
LCD Touch Screen Display. You can use the Virtual Keyboard either with 
the four-way touch pad and control panel buttons, or using the touch screen 
display directly. 
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At the top of the screen is the data field you are entering data into, in this 
case”A1234567890A”. Also in this field is the underscore cursor, which 
graphically shows where the next character will be placed. Up to 25 
characters can be stored in the data fields, though only the first 15 will be 
displayed on the analyzer’s touch screen.

Next is the Virtual Keyboard itself, with numbers 0-9, letters A-Z, the 
special characters *,<,>, and -, and the Shift key, to toggle between upper 
and lower case keyboards.

Last is the control key line. This contains the keys for Return, Space, Clr, 
and Backspace. The Return key will enter the data and return you to the 
Data Entry Screen, the Backspace key will delete the last entered character, 
the Space key will insert a space at the cursor position, and the Clr screen 
button will clear the data you have entered.

Since the Virtual Keyboard is oriented 90 degrees from the standard in 
order to use a landscape display, the down portion of the 4-way touch-pad 
will select the key to the right of the current position, the left portion will 
select the key immediately below, the up portion will select the key to the 
left, and the right portion will select the key will select the key immediately 
above, Use the Select and Enter button to enter the currently selected key.
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All Alloys Analysis
All Alloys Analysis

Figure 1-13. All Alloys Menu Path

From the All Alloys Test Menu, you can immediately initiate a sample test 
using the proper preconditions for operation, enter data about your sample 
using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the All Alloys Test Menu to go to the 
“The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

In this mode, the analyzer will test the chemistry it detects against the 
chemistries in the NITON Alloy Library to find the best match. 
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All Alloys Analysis
Figure 1-14. All Alloys Reading Screen

In Figure 1-14, the reading is showing a Match with 317SS after 2.8 
seconds. The Match Number is at 1.5, which is a Good Match at 2.0 or less. 
Further testing time is not needed.
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All Alloys Analysis
Figure 1-15. SpectraView Spectrum

Figure 1-15 shows a SpectraView screen. This screen, accessible through the 
NAV menu, shows the spectrum of a reading qualitatively. See Appendix C 
for details.
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Cu/Zn/Pb Analysis

Figure 1-16. Cu/Zn/Pb Menu Path

To access the Cu/Zn/Pb Test Menu, select the Alloys with Cu/Zn/Pb 
icon from the Chemistry Mode Menu. From the Cu/Zn/Pb Test Menu, 
you can immediately initiate a sample test using the proper preconditions 
for operation, enter data about your sample using the Data Entry icon, or 
return to the Main Menu.

Select the Data Entry icon from the Cu/Zn/Pb Test Menu to go to the 
“The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

In Cu/Zn/Pb Chemistry Mode, all other programmed elements are active 
in addition to Cu/Zn/Pb (e.g. Ti, Cr, Mn, Fe, Co, Ni, Zr, Nb, Mo, W, etc.). 
Cu/Zn/Pb Chemistry Mode is recommended if you know, without a 
doubt, that your sample alloy contains Cu, Zn, and/or Pb and not Ta, Hf, 
or Re. When your NITON analyzer is operating in Cu/Zn/Pb Chemistry 
Mode the NITON analyzer will not measure concentrations of Ta, Hf, or 
Re in a sample. In this mode, the analyzer will test the chemistry it detects 
against the chemistries in the NITON Alloy Library to find the best match. 
In all other respects, the Cu/Zn/Pb Mode works in the same manner as the 
All Alloys Mode.
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Ta/Hf/Re Test Menu

Figure 1-17. Ta/Hf/Re Menu Path

To access the Ta/Hf/Re Test Menu, select the Alloys with Ta/Hf/Re icon 
from the Chemistry Mode Menu. From the Ta/Hf/Re Test Menu, you 
can immediately initiate a sample test using the proper preconditions for 
operation, enter data about your sample using the Data Entry icon, or 
return to the Main Menu.

Select the Data Entry icon from the Ta/Hf/Re Test Menu to go to the 
“The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

In Ta/Hf/Re Chemistry Mode, all other programmed elements are active 
in addition to Ta/Hf/Re (e.g. Ti, Cr, Mn, Fe, Co, Ni, Zr, Nb, Mo, W, etc.). 
Ta/Hf/Re Chemistry Mode is recommended if you know, without a 
doubt, that your sample alloy contains Ta, Hf, and/or Re and not Cu, Zn, 
or Pb. When your NITON analyzer is operating in Ta/Hf/Re Chemistry 
Mode the NITON analyzer will not measure concentrations of Cu, Zn, or 
Pb in a sample. In this mode, the analyzer will test the chemistry it detects 
against the chemistries in the NITON Alloy Library to find the best match. 
In all other respects, the Ta/Hf/Re Mode works in the same manner as the 
All Alloys Mode.
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Match Signature Analysis
Match Signature
Analysis

Figure 1-18. Match Signature Menu Path

From the Match Signature Menu, you can immediately initiate a sample 
test using the proper preconditions for operation, enter data about your 
sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Match Signature Test Menu to go 
to the “The Data Entry Screen” on page 1-50, to input data about the 
sample which you are testing. The data you enter will be associated with the 
next sample you test.

When you take a measurement of the test sample, your analyzer will 
compare the signature of this unknown sample against signatures of 
reference samples in Match Signature Mode.
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Match Signature Analysis
Figure 1-19. Matching a Reference Sample with Match Signature 
Analysis
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The Store Signature Screen
The Store Signature
Screen

Figure 1-20. The Store Signature Menu Path

From the Store Signature Menu, you can immediately initiate a sample 
test using the proper preconditions for operation, enter data about your 
sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Store Signature Menu to go to the 
“The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

After the data entry is complete, take a 60 second minimum measurement 
of the reference sample you have named. The analyzer will build a signature 
of this reference sample to compare against unknown samples in Match 
Signature Mode. 

CAUTION When teaching your analyzer a new alloy signature in Match 
Signature Mode, the measurement must be taken for at least a full 60 
nominal seconds, as displayed on your analyzer's touch screen display. �
Thermo Scientific NITON XL3 Analyzer User’s Guide 1-33
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Figure 1-21. Producing a Signature Reading of a Reference Sample
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SuperChem Analysis
SuperChem Analysis

Figure 1-22. The SuperChem Test Menu Path

From the SuperChem Test Menu, you can immediately initiate a sample 
test using the proper preconditions for operation, enter data about your 
sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the SuperChem Test Menu to go to the 
“The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.
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SuperChem Analysis
Figure 1-23. SuperChem Test Results Screen

While your analyzer is analyzing the alloy, you will see a screen similar to 
Figure 1-23. This screen will be displayed on your display until a matching 
reference sample is found. The 2 Sigma Error means that it is 95% certain 
that the actual value varies no more than this amount from the reported 
value. The Alloy Name Confidence Number is a best fit calculation. The 
closer this number is to zero, the better the match.

The analysis will continue until you stop it, with the analysis getting more 
refined as time goes on. When you stop the reading, the screen stops 
updating and stays the same, as in Figure 1-23.

Reading Number

Test Time in Seconds

& Test Mode

Alloy Name 
(or No Match)

Confidence Number

Element detected Percentage of Element

2 Sigma Error
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SuperChem Analysis
Figure 1-24. No Match Screen

If the XRF Analyzer determines that the sample that you are testing does not 
match any of the samples that you have specified in your library, it displays 
“No Match.”
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The SuperChem Teach
Menu

Figure 1-25. The SuperChem Teach Menu Path

From the Super Chem Teach Menu, you can immediately initiate a 
sample test using the proper preconditions for operation, enter data about 
your sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the SuperChem Teach Menu to go to 
the “The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

After the data entry is complete, take a 60 second measurement of the 
reference sample you have named. The analyzer will build a signature of this 
reference sample to compare against unknown samples in SuperChem 
Mode. 
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The SuperChem Teach Menu
Figure 1-26. The SuperChem Teach Mode Reading Screen

While your analyzer is analyzing the alloy, you will see a screen similar to the 
screen in Figure 1-26. The screen shows the counts per second for each 
element, and the default (zero) percentage of each element in this alloy. 
However, if the name of the sample matches one of the entries in the 
SuperLib, then that chemistry will be automatically filled in.

Reading Number

Test Time in Seconds

Sample Name

Percent of Element
Number of counts per element

Element detected
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The SuperChem Teach Menu
Figure 1-27. SuperChem Teach Composition Screen

When you stop the reading, the screen changes to a new configuration 
showing the alloy elements in one column and a second column filled with 
zeros. The zeroes are the default percentages of elements actually contained 
in the sample. By selecting a blank percentage, you may edit the 
composition percentages to conform precisely to the certified values of your 
particular reference. 

The Super Chem Teach Composition Screen is scrollable, and lists each 
element used in the analyzer’s alloy analysis. Use the 4-way touch pad to 
move through the listing, and the enter button to select the element you 
wish to edit. Entering the percentages is done through an interface similar to 
the one used to log in, as described below and as shown in Figure 1-28.

Note All constituent element percentages for a SuperChem alloy must add 
up to approximately 100%. If an element is listed as “Balance,” that 
element’s concentration must be determined and entered into the 
SuperChem Teach data entry screen. For all non Helium purged analyzers, 
if a certification does not equal 100%, then the remaining concentration of 
unmeasurable elements must be summed and entered as Al. �
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The SuperChem Teach Menu
Figure 1-28. SuperChem Teach - Inputting Composition

Again, you can use the 4-way touch pad to navigate and the enter key to 
select, or use the LCD touch screen. First, always select the “C” button to 
clear the entire percentage to a blank state. Otherwise the numbers you 
input will be appended onto the default percentage (zero). Selecting the “<“ 
button erases the last number entered, and selecting the “E” key enters the 
percentage into the field associated with the element you are working on. 
NITON uses 2 significant digits after the decimal point, and anything 
beyond 2 places is truncated. 

Identifies the 
value being 
changed

Use to erase the 
existing value
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Analysis and Sorting
of Aluminum Alloys

Note The information in this section pertains to non-Helium purged 
analyzers (or Helium purged analyzers run without purge) only. �

Introduction The NITON X-ray fluorescence (XRF) alloy analyzers provide outstanding 
sorting and analysis capability for alloy families such as red metals, low alloy 
steels, stainless steels, high temperature alloys, nickel alloys, nickel/cobalt 
alloys, cobalt alloys, titanium alloys, tool steels, tungsten alloys, and other 
exotic alloys. Because of the robust, standardless, fundamental parameters 
(FP) calibration technology now available in NITON portable XRF 
analyzers, these alloy groups are ideally suited for the XRF technology. 
Calibrations can cover the range from detection limit to 100% 
concentration with extremely high accuracy. However, aluminum alloys are 
generally best analyzed by Optical Emission spectrometers.

Comprehensive sorting of aluminum alloys requires analysis of elements too 
“light” for portable XRF analysis, such as magnesium, silicon, and 
aluminum, in addition to the other alloying elements that are in the 
measurement range for portable XRF. Aluminum, silicon, and magnesium 
are all combined in the ‘element’ labeled “Al” content, which is computed 
by subtracting the detected elements from 100%. This limits portable XRF 
analyzers to sorting of wrought aluminum by series and/or some specific 
aluminum grades within a particular series. Sorting capabilities include the 
1000, 2000, 3000, 6000 and 7000 series. Some 4000 and 5000 alloys can 
be determined, but only if they have a unique alloying content based on 
elements other than Si or Mg (different from any other aluminum grade in 
the same or any other series). Separating cast aluminum alloys that differ 
only in Si content is not possible with XRF. 

Performance Reliable separation of common alloy grades such as 1100, 2024, 3003, 
6061, 6063, 7050, and 7075 from each other is possible since these alloys 
do not depend on “light elements” for discrimination. Instead, the elements 
Mn, Fe, Cu, Zn and Zr constitute the differentiating alloying elements in 
the above examples. Since many 5000 series wrought aluminum alloys are 
different only in Mg, and many 4000 wrought aluminum alloy series are 
different only in Si, grade determination within these groups is only 
sometimes, but not always, possible. The NITON analyzer chemistry is 
quite reliable and accurate for the elements listed below under “sorting 
requirements”. The attached results are typical of what can be expected.

Sorting requirements The NITON analyzer will sort those specific aluminum alloys which differ 
by a few tenths of a percent or more of the detectable alloying elements. 
Detectable alloying elements found in aluminum alloys include Ti, V, Cr, 
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Mn, Fe, Ni, Cu, Zn, Zr, Pb, Bi, Ag, and Sn. The light elements Mg, Si or Al 
are not detectable using portable XRF, without use of a helium purge 
system. 

Specific needs Please contact your local NITON Analyzer representative for further 
information, or to discuss your specific aluminum alloy sorting needs. Based 
on the grades you expect to encounter, Thermo can advise you on the 
feasibility of meeting your sorting requirements.

Typical Measurement Results Table: (Tube Source)

Table continued:

* Includes all Light Element Content (e.g., Al and Si and/or Mg)

Standard ID 
NITON

Al 
Act*

Al 
NITON

Al Err Zr 
Act

Zr 
NITON

Zr Err Zn 
Act

Zn 
NITON

Zn Err

1100-101A 1100 99.22 99.24 0.17 0.01 0.01 0.01 0.03 0.02 0.01

6061-109B 6061 98.89 98.98 0.2 0.003 0 0.01 0.044 0.04 0.01

7050-231AC 7050 90.45 90.8 0.65 0.13 0.12 0.02 6.3 6.29 0.39

2024-104A 2024 94.03 94.46 0.38 0.01 0.01 0.01 0.017 0.04 0.02

7075-111AD 7075 91.33 91.79 0.57 0.032 0.03 0.01 5.87 5.82 0.35

6063-225A 6063 99.41 99.5 0.16 0.004 0 0.01 0.03 0.03 0.01

3003-105AH 3003 97.96 98.1 0.22 0.003 0 0.01 0.02 0.02 0.01

Standard Cu 
Act

Cu 
NITON

Cu 
Err

Fe 
Act

Fe 
NITON

Fe 
Err

Mn 
Act

Mn 
NITON

Mn 
Err

Cr 
Act

Cr 
NITON

Cr 
Err

1100-101A 0.09 0.08 0.02 0.6 0.48 0.06 0.03 0.02 0.03 0.02 0.03 0.05

6061-109B 0.32 0.28 0.03 0.26 0.23 0.05 0.08 0.1 0.04 0.21 0.15 0.07

7050-231AC 2.36 2.42 0.15 0.13 0.12 0.05 0.08 0.09 0.06 0.026 0 0.08

2024-104A 4.66 4.35 0.24 0.25 0.25 0.05 0.65 0.72 0.09 0.016 0 0.06

7075-111AD 1.69 1.73 0.11 0.28 0.26 0.05 0.048 0.04 0.05 0.21 0.17 0.09

6063-225A 0.08 0.07 0.01 0.21 0.17 0.04 0.083 0.09 0.04 0.024 0.03 0.05

3003-105AH 0.088 0.08 0.02 0.61 0.53 0.06 1.08 1.1 0.1 0.02 0.03 0.06
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Disabling Aluminum Analysis
Disabling Aluminum
Analysis

In either Alloy Mode or Electronics Alloy Mode, you can disable the analysis 
of aluminum if you prefer. To disable aluminum analysis, while showing the 
Ready to Test screen or the Reading Display screen, select  the Tools Menu, 
then select Disable Al from the menu, as in Figure 1-29.

Once disabled, aluminum will not be analyzed, and when downloaded to 
NDT, a "No Al" flag will be set for that reading. Aluminum analysis cannot 
be disabled for helium -purged instruments using the Light Filter, as 
aluminum is required for that setting to function properly.

Figure 1-29. Disabling Al Analysis from the Tools Menu
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Disabling Aluminum Analysis
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Analyzing Metal Alloy Samples
Analyzing Metal Alloy
Samples

CAUTION After being powered on, your NITONnalyzer will perform an 
internal re-calibration before an analysis is initiated. It is recommended that 
you let your analyzer warm up for ten minutes after start up, before testing is 
begun. �

There are six different methods of operation for taking a sample 
measurement, and your analyzer will be configured to use one of those 
methods for alloy samples, depending on the regulatory requirements of 
your locality. These methods are:

• Trigger-Only method. With the Trigger-Only method, you only need to 
place the measurement window flush with the sample to be analyzed 
and pull the trigger for sample analysis to be initiated. 

• Trigger-and-Proximity-Sensor method. With the 
Trigger-and-Proximity-Sensor method, you must place the measurement 
window against the sample to be analyzed to engage the proximity 
sensor on the front of the analyzer, then pull the trigger for sample 
analysis to be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With the 
Momentary-Trigger-Touch-and-Proximity-Sensor method, you must 
place the measurement window against the surface to be analyzed to 
engage the proximity sensor on the front of the analyzer, then pull the 
trigger. The trigger may be released and the reading will continue until 
you release the proximity button, or other criteria (such as Max Time) 
are reached. 

• Trigger-and-Interlock method. With the Trigger-and-Interlock method, 
you need to place the measurement window close to the sample to be 
analyzed, press and keep pressing the interlock button at the rear of the 
analyzer with your free hand, then pull the trigger for sample analysis to 
be initiated.

• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the 
measurement window against the sample to be analyzed to engage the 
proximity sensor on the front of the analyzer, press and keep pressing the 
interlock button at the rear of the analyzer with your free hand, then 
pull the trigger for sample analysis to be initiated.
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Analyzing Metal Alloy Samples
• Easy Trigger method. With the Easy trigger method, you need only 
place the measurement window against the sample area and pull the 
trigger once to initiate a sample analysis. Your analyzer will continuously 
sample the backscatter, using a complex internal algorithm, to 
determine if the measurement window is against a sample or pointing to 
the empty air. If it finds that there is no sample directly against the 
measurement window, the analyzer will stop directing radiation through 
the window as soon as this determination is made.

Note The analyzer is constantly checking the backscatter characteristics to 
determine if a sample is against the measurement window, whether or not 
the Easy Trigger method is being used, and will shut off any radiation 
directed through the window if it determines that there is no sample 
present.

With any of these methods, analysis will stop if any one of the preconditions 
are violated. For example, with the Trigger-Interlock-and-Proximity-Sensor 
method, if the trigger or the Proximity Sensor or the Interlock is released, 
the reading will stop immediately, and the X-ray tube will shut down.

After your analyzer is calibrated, initiate a sample reading using the 
appropriate method. If you attempt to initiate a sample reading using a 
different method, the analyzer will inform you that one or more of the 
preconditions need to be met in order for sample analysis to begin. 

Note The four LED lights will blink whenever the x-ray tube is on. �

WARNING! The preconditions for operation must be continued for the 
duration of the reading. If the preconditions are violated, the x-ray tube will 
turn off, the calibration shutter will close, and the measurement will end. 
The four LED lights will stop blinking when the measurement is ended. 
The flashing of the LED lights is not synchronized to minimize power 
consumption. �

To end the test, simply release the trigger mechanism, or any other 
applicable preconditions.
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Analyzing Metal Alloy Samples
WARNING! When all four LED lights are blinking, the x-ray tube is on. 
This should only occur during a measurement, while the preconditions for 
operation are met. On startup, the front pair of lights will blink. If the LED 
lights blink at any other time, disconnect the battery pack and call Thermo 
Scientific’s Service Department in the United States, toll free, at (800) 
875-1578, or outside the United States, at +1-978-670-7460, or your local 
Authorized NITON Analyzer Service Center. �

Note The preconditions for operation may be limited or dictated by the 
country of operation, and thus some preconditions may not be available as 
customer options. �
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The Data Entry Screen
The Data Entry Screen The Data Entry Screen is accessed whenever you select the Data Entry 
icon from any screen. This screen allows you to input data in several 
different fields, or categories, concerning your sample, in several different 
ways:

• By selecting the Virtual Keyboard button and typing the parameter in 
using the Virtual Keyboard. 

• By creating a new, or editing your analyzer's existing, '.ndf' file through 
the NDT program. You can then select from the various custom options 
you have created using the Drop-down List button.

These fields are saved along with the subsequent reading, and allow you to 
associate important information about the sample directly with the reading, 
so that you have a full description of the sample tied into the reading itself.

Once you have input data into a field, that information carries over into the 
next reading, so that you only have to input the information that has 
changed since the last reading. For example, if you are analyzing several 
samples of a particular lot, you only need to input the lot information once 
during that series of readings, changing only the sample name.

Figure 1-30. The Data Entry Screen - First page

Virtual Keyboard
Button

Parameter Field 
Name

Drop-down List
Button

Parameter Field
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The Data Entry Screen
This is the first section of the Data Entry Screen. There are five 
parameters in this section.

Selecting Sample allows you to input the sample name parameter

Selecting Heat allows you to input the particular heat information, if 
known

Selecting Lot allows you to input the Lot parameter.

Selecting Batch allows you to input information on the alloy’s Batch 
number

Selecting Misc allows you to input miscellaneous parameters

Figure 1-31. The Data Entry Screen - Second Page

This is the second section of the Data Entry Screen. There is one 
parameter in this section.

Selecting Note allows you to input notes on the sample
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The Data Entry Screen
You may enter up to 25 characters in the data entry fields. These 25 
characters are saved, and are all visible in NDT, but only the first 15 
characters are visible in the field on your analyzer.

Selecting Data Entry from
View Data Mode

You can select Data Entry from the NAV Menu while in View Data Mode, 
but the ability to edit or enter data is disabled. The screen will show the data 
already entered, with no buttons for drop down menu selection or Virtual 
Keyboard.

Figure 1-32. Data Entry Screen while Viewing Data
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Navigating the Data Entry Screen
Navigating the Data
Entry Screen

Figure 1-33. The Control Panel

The following description of screen navigation using the control panel 
assumes that the analyzer is held so that the display is held upright as in 
Figure 1-33.

• To move from column to column, use the Right and Left portion of the 
4-way touch pad.

• To move from row to row, use the Up and Down portions of the 4-way 
touch pad.

• To select the highlighted option, press the Enter button on the control 
panel. 

The Data Entry Screen is divided into sections of 5 setting parameters. By 
using the Down portion of the 4-way touch pad when you are on the last 
row of a section, the display will change to the next section. By using the Up 
portion of the 4-way touch pad when you are on the first row of a section, 
the display will change to the previous section. 

By selecting the On/Off button, you can exit the Data Entry Screen.

Touch Screen 
Display

On/Off 
Button

Down

Right

4-way
 touch-pad

Up

Enter
Button

Left
Thermo Scientific NITON XLp Analyzer User’s Guide 1-53



The Virtual Keyboard
The Virtual Keyboard

Figure 1-34. Lower Case Virtual Keyboard

Figure 1-35. Upper Case Virtual Keyboard
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The Virtual Keyboard
The Virtual Keyboard is an alphanumeric keyboard which appears on the 
LCD Touch Screen Display. You can use the Virtual Keyboard either with 
the four-way touch pad and control panel buttons, or using the touch screen 
display directly. 

At the top of the screen is the data field you are entering data into, in this 
case”A1234567890A”. Also in this field is the underscore cursor, which 
graphically shows where the next character will be placed. Up to 25 
characters can be stored in the data fields, though only the first 15 will be 
displayed on the analyzer’s touch screen.

Next is the Virtual Keyboard itself, with numbers 0-9, letters A-Z, the 
special characters *,<,>, and -, and the Shift key, to toggle between upper 
and lower case keyboards.

Last is the control key line. This contains the keys for Return, Space, Clr, 
and Backspace. The Return key will enter the data and return you to the 
Data Entry Screen, the Backspace key will delete the last entered character, 
the Space key will insert a space at the cursor position, and the Clr screen 
button will clear the data you have entered.

Since the Virtual Keyboard is oriented 90 degrees from the standard in 
order to use a landscape display, the down portion of the 4-way touch-pad 
will select the key to the right of the current position, the left portion will 
select the key immediately below, the up portion will select the key to the 
left, and the right portion will select the key will select the key immediately 
above, Use the Select and Enter button to enter the currently selected key.

All screen areas can be directly accessed using the LCD Touch Screen by 
touch.
Thermo Scientific NITON XLp Analyzer User’s Guide 1-55



The Results Screen
The Results Screen Your NITON Analyzer will display the Results Screen throughout the 
duration of each reading, The Results Screen is updated regularly 
throughout the reading. When the reading is complete, a final screen update 
will appear, and your NITON analyzer will display the final results of the 
measurement which has just been completed.

Figure 1-36. The Results Screen

The Results Screen displays the following information:

• The Reading Number shows a number sequentially assigned by your 
NITON analyzer in order to uniquely identify each reading. The 
reading number automatically increments with each successive reading.

• The Nominal Seconds Test Duration line shows the number of 
nominal (source) seconds elapsing since the initiation of the reading. 
Nominal seconds are instrument time designed to compensate for the 
electronic dead-time that may occur when your analyzer is taking a 
measurement, and therefore tend to be a bit slower than real time. 

• The Mode displays the test mode in use during the measurement.

Match/No 
Match Line 

Element 
Column

Concentration 
Level Column

Confidence 
Column 

Mode 
Nominal Seconds 
Line

Reading 
Number 

NAV Menu

Tools Menu
Battery Life 
Indicator

Match Number
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Match Number
• The Match/No Match line indicates whether your NITON analyzer 
has found a matching alloy in it's library for the sample you have 
measured, and displays the name(s) of any matching alloys and the 
Match Number (chi squared deviation).

• The Element (left) column shows the elements that have been detected 
in the sample. 

• The Concentration Level (central) column shows the concentration 
levels of the corresponding elements in percentages.

• The Confidence (right) column displays the 2 sigma (95%) confidence 
interval for the corresponding elements.

If there are too many elements detected to fit onto a single screen, you can 
see the balance of the elements and their results (as in figure 3-16) by 
pressing the down arrow of the 4-way touch pad. To see previous results, 
use the left arrow of the 4-way touch pad. To go forward to later readings, 
use the right arrow of the 4-way touch pad.

Match Number The Match Number is a rating of confidence in the identification of the 
alloy. The Match number ranges from 0.0 to 10.0, with 0.0 being a perfect 
match. Any number greater than 4.0 gives a result of No Match by default, 
although you can change this match threshold. Any number less than 2.0 is 
considered a Good Match, and can usually be brought closer to 0.0 with 
longer testing times. Numbers between 2.0 and 3.0 can be considered 
Probable Matches, and numbers between 3.0 and 4.0 as Possible Matches, 
often having one or more elements out of spec.
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Camera and Small Spot Video
Camera and Small
Spot Video

The Camera feature is only usable with properly configured analyzers, and 
the Small Spot feature is only available on Small Spot analyzers. 

If your analyzer is equipped with an internal video camera, you can turn 
that camera on and off, and turn the saving of images with the readings on 
and off through an interface. When the camera is on, the image will show in 
the Ready to Test screen, as in Figure 1-4. If the camera is off, saving of 
images will also be off. If the camera is on and the image saving function is 
also on, the images will automatically be saved with the reading. Saving 
images will curtail the maximum number of readings stored.

How to Use the Camera When a Camera equipped XL3 analyzer is in the Ready to Test screen, the 
video feed appears live on the analyzer’s touch screen. This is the image that 
can be saved with the sample analysis. When you take a measurement, if you 
choose to do so, the bitmap image will be saved on the analyzer along with 
the analysis results. The interface is accessible through the Instrument 
Setup/Hardware Setup menu, as in Figure 1-2. 

Figure 1-1. The Hardware Setup Menu Path
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Camera and Small Spot Video
Figure 1-2. Setting Up the Camera View and Image Saving

Stored camera images from previous measurements can be viewed on the 
analyzer.

How to Use the Small Spot
Technology

With a properly equipped Small Spot analyzer, you can restrict the analysis 
to a small spot within the camera view. You can toggle the Spot on and off 
from the Tools Menu as in Figure 1-3.

A red circle with a small hash mark (#) will appear on the display. The small 
hash marks the center of the x-ray analysis spot, while the larger circle marks 
the area analyzed. 
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Camera and Small Spot Video
Figure 1-3. Toggling the Small Spot from the TOOLS Menu

Figure 1-4. Camera View
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Using the Small Spot
Using the Small Spot The Small Spot can be used in several different modes.

Mining 3mm spot size allows analysis of veins and inclusions in mineral samples

Initiate from Tools - Small Spot

He Purged Helium purge allows analysis of light elements (Mg, V and Ti)

Small spot enables analysis of light elements in welds and inclusions

Helium and Small Spot modes can be used simultaneously for Alloy and 
Mining modes
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Consumer Goods Analysis
Consumer Goods
Analysis

Figure 1-5. Consumer Goods Menu Path

From the Consummer Goods Analysis Menu, you can initiate analysis in 
TestAll Mode, Metals & Minerals Mode, Plastics Mode, or Painted 
Products Mode.

This menu enables you to choose betwen these several different modes for 
use in testing consumer products. Consumer Goods tests return a result of 
Pass, Fail, or Inconclusive relative to the criteria set in Toy Mode Settings.
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TestAll Analysis
TestAll Analysis

Figure 1-6. TestAll Menu Path

To access the TestAll Test Menu, select the TestAll Mode icon from the 
Consumer Goods Analysis Menu. From the TestAll Test Menu, you 
can immediately initiate a sample test using the proper preconditions for 
operation, enter data about your sample using the Data Entry icon, or 
return to the Main Menu.

Select the Data Entry icon from the TestAll Test Menu to go to “The 
Data Entry Screen” on page 1-50, to input data about the sample which you 
are testing. The data you enter will be associated with the next sample you 
test.

Use TestAll Mode when you are uncertain whether one of the more specific 
Consumer Goods modes would be more appropriate. TestAll Mode analyzes 
the matrix and selects the classification most appropriate to the test, then 
applies the appropriate calibration to the data. 
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TestAll Analysis
Figure 1-7. Matrix Analysis Screen And Plastic Result Screen

Table 1-1. Test All Categories

Category Description of Category

Metal Bulk, unpainted metals and metallic alloys

Painted Metal Painted metal surfaces

Thin Metal Foils and very thin metallic samples

Plastic Non-PVC plastics, unpainted wood, cardboard, 
and fibres

PVC Plastic PVC plastics, and any material with a lot of 
chlorine

Thin Plastic Thin non-PVC plastics

Aluminum Alloys Aluminum based alloys

Layered Materials Layered non-metals, coated items, glazed 
ceramics

Non-Metal Soils, minerals, unglazed ceramics, oxides, 
concrete, sheetrock, sometimes pure aluminum

Other Similar to Non-Metal, but includes anything which 
fails the algorithm for Non-Metal. 
Thermo Scientific NITON XL3 Analyzer User’s Guide 1-65



TestAll Analysis
Metal Bulk, unpainted metals and metallic alloys will be classified as Metal.  If the 
system ID’s the sample as a metal it will display the alloy grade match as 
well, but not the match number.

Painted Metal This is for painted metal surfaces.  This is specifically suitable for painted 
metal toys, die cast objects, and other painted metal surfaces.

Thin Metal This is for thin metal materials.

Plastic This is for non-PVC plastic and samples exhibiting high intensity of 
Compton scatter. Wood will is also fall in this category as its chemical 
makeup is very similar to non-PVC polymers and it generates spectra very 
similar to those of polymers.

PVC Plastic This is for all PVC Type plastics, regardless of thickness of sample. Note, 
since PVC determination is based on Cl content, any material with high Cl 
signal will force the PVC Plastic determination.

Thin Plastic Thin polymer (non-PVC type) samples fall in this class.

Aluminum Alloys Obviously, aluminum alloys belong to this class. However,  pure Al 
generates spectral signal so similar to Non-Metal type, that it will often be 
identified as such.

Layered Materials This class includes samples of layered nonmetals, but not necessarily 
painted. In this case the outer layer is thick enough to modify spectrum in 
such a way that we can identify two layers of different materials sandwiched 
together.  A typical examples include glazed ceramics.

Non-Metals This class encompasses bulk, non-metallic and non-plastic materials, such as 
oxides. This is a large group which includes variety of materials such as soil, 
ceramics, concrete, and sheetrock.

Other Similar to non-metal class but for some unexpected reason (such as 
non-typical element) the algorithm cannot classify the measured material 
into any of the other types.
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Metals & Minerals Analysis
Metals & Minerals
Analysis

Figure 1-8. Metals & Minerals Menu Path

To access the Metals & Minerals Test Menu, select the Metals & 
Minerals Mode icon from the Consumer Goods Analysis Menu. From 
the Metals & MineralsTest Menu, you can immediately initiate a sample 
test using the proper preconditions for operation, enter data about your 
sample using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Metals & Minerals Test Menu to go 
to “The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

Use Metals & Minerals Mode when your sample is unpainted metal, soil, 
or ceramic.
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Consumer Plastics Analysis
Consumer Plastics
Analysis

Figure 1-9. Plastics Menu Path

To access the Plastics Test Menu, select the Plastics Mode icon from the 
Consumer Goods Analysis Menu. From the Plastics Test Menu, you 
can immediately initiate a sample test using the proper preconditions for 
operation, enter data about your sample using the Data Entry icon, or 
return to the Main Menu.

Select the Data Entry icon from the Plastics Test Menu to go to “The 
Data Entry Screen” on page 1-50, to input data about the sample which you 
are testing. The data you enter will be associated with the next sample you 
test.

Use Consumer Plastics Mode when your sample is plastic - PVC or 
non-PVC.
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Painted Products Analysis
Painted Products
Analysis

Figure 1-10. Painted Products Menu Path

To access the Painted Products Test Menu, select the Painted Products 
Mode icon from the Consumer Goods Analysis Menu. From the 
Painted Products Test Menu, you can immediately initiate a sample test 
using the proper preconditions for operation, enter data about your sample 
using the Data Entry icon, or return to the Main Menu.

Select the Data Entry icon from the Painted Products Test Menu to go 
to “The Data Entry Screen” on page 1-50, to input data about the sample 
which you are testing. The data you enter will be associated with the next 
sample you test.

Use Painted Products Mode for analysis of goods with a paint layer over a 
substrate. If lead is found to be on the surface, it will be reported in units of 
µg/cm2. All other elements will be reported in units of mg/kg or %.
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The View Data Screen
The View Data Screen

Figure 1-11. The View Data Menu Path

Use the Data Screen to view previously taken test result readings. When the 
View Data icon is selected, the Results screen of your most recent test is 
shown on the LCD display. 

Using the buttons on the control panel, you may view different readings or 
additional data for individual readings.

Your analyzer will display the standard screen analysis. Pressing the "Down" 
arrow on the 4-way touch pad will display a complete scrolling elemental 
chemistry listing. Each press of the “Down” arrow scrolls the screen down to 
the next element. You can also use the scroll bar along the right side to scroll 
or page through the elements.
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The View Data Screen
Scrolling Down Through
the Complete Listing of

Elements

Figure 1-12. Complete Listing of Elements

Pressing the "Left" arrow on the 4-way touch pad of your analyzer will 
display the previous reading, or if the first reading is currently displayed, the 
last reading. Pressing the "Right" arrow on the 4-way touch pad will display 
the next reading, or if the last reading is currently displayed, the first reading 
in memory. NITON Analyzers can store between 3000 to 6000 readings.

You can also look at the complete x-ray spectra for each reading stored in the 
analyzer's memory. 

Sorting Elements You can sort element rows by various criteria in order to view your data in 
the manner you prefer.The Sort Buttons, which double as column headings, 
can be used to re-sort the data in different ways. The Data Screen always 
begins as a Standard Sort, as you have defined it. Selecting the appropriate 
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The View Data Screen
sort button once toggles the sort order to High-to-Low. Selecting the sort 
button again toggles the sort order to Low-to-High. To return to the 
Standard Sort, view a different reading and return.

Figure 1-13. Element Sorts

Element Sorts Element sorts are performed alphabetically based on the element name.

Composition Sorts Composition sorts are performed numerically based on the percentage of 
composition.

Error Sorts Error sorts are performed based on the range of error in the reading.

Spectrum Graph For any reading result, simply use the NAV Menu to gain access to the 
reading’s spectrum graph. Selecting Spectra will show a graphed spectrum of 
this reading, called SpectraView. SpectraView can be a useful tool for rapid, 
qualitative analysis of a sample. See “SpectraView” on page Appendices-vii 
for details.

Standard Sort Low-to-High Sort High-to-Low Sort
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The View Data Screen
Figure 1-14. The SpectraView Screen
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The Erase All Data Screen
The Erase All Data
Screen

Figure 1-15. The Erase All Data Menu Path

Select the Erase All Data icon to erase all data, including signatures and 
SuperChem reference readings, from your analyzer. Selecting the Erase All 
Data icon will bring up a confirmation screen (see upper left) asking you 
“Are you sure?” with options to select “YES” or “NO”. Selecting “YES” will 
erase all reading data from your analyzer. Selecting “NO” will return you to 
the Erase Menu.

CAUTION Never turn off the analyzer while data is being erased! �

WARNING!  Do not attempt to take measurements while downloading 
readings! This will generate an error requiring a system reset, and may 
corrupt your stored readings, requiring all stored readings to be erased. �
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The Erase Readings Screen
The Erase Readings
Screen

Figure 1-16. The Erase Readings Menu Path

Select the Erase Readings icon to erase all accumulated test readings from 
your analyzer. Selecting the Erase Readings icon will bring up a 
confirmation screen (see upper left) asking you “Are you sure?” with options 
to select “YES” or “NO”. Selecting “YES” will erase all test reading data 
from your analyzer. Selecting “NO” will return you to the Erase Menu.

Note We recommend that you download all your readings into an NDT file 
for recording purposes before erasing all data. �
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The Erase Signatures Screen
The Erase Signatures
Screen

Figure 1-17. The Erase Signatures Menu Path

Select the Erase Signatures icon to erase all accumulated alloy signatures 
from your analyzer. Selecting the Erase Signatures icon will bring up a 
confirmation screen (see upper left) asking you “Are you sure?” with options 
to select “YES” or “NO”. Selecting “YES” will erase all signature data from 
your analyzer. Selecting “NO” will return you to the Erase Menu.
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The Erase SuperChem Screen
The Erase SuperChem
Screen

Figure 1-18. The Erase SuperChem Menu Path

Select the Erase SuperChem icon to erase accumulated SuperChem 
reference readings from your analyzer. Selecting the Erase SuperChem 
icon will bring up a confirmation screen (see upper left) asking you “Are you 
sure?” with options to select “YES” or “NO”. Selecting “YES” will erase all 
SuperChem reference reading data from your analyzer. Selecting “NO” will 
return you to the Erase Menu.
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The Erase SuperPrec Screen
The Erase SuperPrec
Screen

Figure 1-19. The Erase SuperPrec Menu Path

Select the Erase SuperPrec icon to erase accumulated SuperPrec reference 
readings from your analyzer. Selecting the Erase SuperPrec icon will bring 
up a confirmation screen (see upper left) asking you “Are you sure?” with 
options to select “YES” or “NO”. Selecting “YES” will erase all SuperPrec 
reference reading data from your analyzer. Selecting “NO” will return you to 
the Erase Menu.
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The View Libraries Menu
The View Libraries
Menu

Figure 1-20. The View Libraries Menu Path

Select the View Libraries icon to access the Library View Menu. The 
Library View Menu allows you to view data in the Alloy Grade Library as 
well as the Superlib and Superstds libraries. Just select the library you wish 
to view from the list on screen.

Figure 1-21. Viewing the Alloy Grade Library

The entries in the Grade Library serve as a reference for chemistry based 
analysis. The library entries allow the analyzer to work properly “out of the 
box” without needing time-consuming pre-analysis. Please refer to the NDT 
User Guide for information on modifying the Grade Library.
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The View Signatures Menu
The View Signatures
Menu

Figure 1-22. The View Signatures Menu Path

Select the View Signatures icon to view data saved as reference sample 
signatures in Signature ID Mode. When the View Signatures icon is 
selected, the Results screen of your most recent test is shown on the LCD 
display. 
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The View SuperChem Screen
The View SuperChem
Screen

Figure 1-23. The View SuperChem Menu Path

Select the View SuperChem icon in order to view your SuperChem data. 
The View SuperChem icon allows you to view your SuperChem Mode 
data, and also allows you to delete individual readings.When the View 
SuperChem icon is selected, the Results screen of your most recent 
SuperChem Mode test is shown on the LCD display. 
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The View SuperPrec Screen
The View SuperPrec
Screen

Figure 1-24. The View SuperPrec Menu Path

Select the View SuperPrec icon in order to view your SuperPrec data. The 

View SuperPrec icon allows you to view your SuperPrec Mode data, and 

also allows you to delete individual readings.When the View SuperPrec 

icon is selected, the Results screen of your most recent SuperPrec Mode 

test is shown on the LCD display. 
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The View SuperPrec Screen
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The Calibrate Detector Screen
The Calibrate
Detector Screen

Figure 1-25. The Calibrate Detector Menu Path

Select the Calibrate Detector icon to begin a standard calibration of your 
analyzer’s detector. Once you select the Calibrate Detector icon, 
calibration will begin immediately. The analyzer is programmed to calibrate 
for a specific, predetermined period in order to ensure proper operation of 
your NITONXL3 analyzer in the field.

CAUTION Avoid any vibration, loud noise, strong electronic fields, or other 
possible interference when your analyzer is calibrating its detector. �
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The Calibrate Detector Screen
Figure 1-26. Detector Calibration Screen

The analyzer calibration screen will be displayed until calibration is 
complete. After the calibration has finished, the calibration results will be 
displayed. Press the on/off/escape button or the Return icon to return to 
the Main Menu. In order to insure good test results, it is essential that you 
calibrate your XL3 Analyzer's detector daily, and if a check sample test 
reveals discrepancies in the reading.
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The Calibrate Touch Screen Screen
The Calibrate Touch
Screen Screen

Figure 1-27. The Calibrate Touch Screen Menu Path

Select the Calibrate Touch Screen icon to re-calibrate the analyzer's touch 
screen display. This procedure establishes the display boundaries for the 
touch screen interface. When the Calibrate Touch Screen icon is selected, 
the display will show the message: "Calibrate Touch Screen". There will be a 
small cross in the upper left-hand corner of the display. Tap on this cross 
with the stylus, and the cross will disappear and reappear in the upper 
right-hand corner of the screen. Tap on the cross again, and it will reappear 
in the lower right-hand corner of the screen. Tap on the cross again and it 
will reappear in the lower left-hand corner of the screen. Tap on the cross 
once more, and you will be presented with the Calibrate Menu
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The Calibrate Touch Screen Screen
Figure 1-28. The Touch Screen Calibration Screen
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Calibrating the Touch Screen Without Using the Touch Screen
Calibrating the Touch
Screen Without Using

the Touch Screen

Because there may be a severe issue with the touch screen itself, you may 
need to use the buttons below the screen to complete this process. There are 
3 single buttons and a 4 way switch located to the rear of the display screen. 
The button at the left is the On/Off/Escape button. The button to the right 
is the enter button and the center keypad is a 4 way switch.

The 4 way switch has 4 positions, Up, Down, Left and Right. The select and 
interlock buttons are not used in this procedure.

Figure 1-29. The Control Buttons for the XL3

1. Please, turn on your XRF analyzer using the On/Off button. 

Note From this point please DO NOT touch the touch screen.

2. Press the enter button. You are now at the Radiation warning 
screen.

3. Using the 4 way touch pad on the on the cover of the instrument, 
move the cursor around the screen by pressing the appropriate 
Up down left or right button. Please move the cursor such that 
the Yes option is highlighted in green.

4. Press the “enter” button. You are now at the Enter Password 
Screen.
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Calibrating the Touch Screen Without Using the Touch Screen
5. Move the cursor to the appropriate first number in your 
password and then using the enter button on the right (it has the 
arrow/enter key symbol on it) press this “enter” key. The first 
number of your password should appear in the lower left of the 
LCD screen.

6. Repeat step 5 until you have entered the entire password. Then 
move the cursor to the letter “E” and press the “enter” key to 
enter it.

7. You will now be at the main screen.

8. Again using the four way touch pad, move the cursor to highlight 
the “Utilities” icon and press the “enter” key to select.

9. You will now be at the Utilities screen

10. From the Utilities screen, move the cursor to highlight the 
“Calibrate” icon and press the “enter” key.

11. Now move the cursor to highlight “Calibrate Touch Screen” and 
press the enter key.

12. You are now at the Touch Screen Calibration screen. 

Note You must now use the touch screen for the balance of this procedure

13. In the upper left hand corner you will see a crosshair “+”, using 
the stylus or a pen, tap the center of the “+”.

14. Repeat this for each “+” sign that appears, there should be one 
for each of the 4 corners.

Your touch screen should work properly after this and you may use it from 
this point forward. If it does not, please repeat the process.
1-90 NITON XL3 Analyzer User’s Guide Thermo Scientific



The Specs Screen
The Specs Screen

Figure 1-30. The Specs Menu Path

Select the Specs icon to display the analyzer's specifications. These 
specifications include your NITON analyzer's serial number, software and 
firmware versions, temperature, bias, and data coprocessors. Press the Close 
button to return to the Utilities Menu.
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The Date and Time Screen
The Date and Time
Screen

Figure 1-31. The Date and Time Menu Path

Select the Date & Time icon to set the date and time as needed for different 
time zones, daylight savings time, or any other reason. The date and time 
are factory preset prior to shipping. The format used is month/day/year - 
MM/DD/YY, and hour/minute - HH/MM, for the 24 hour clock. 

Figure 1-32. Setting the Date & Time

When the Date & Time icon is selected, the Date & Time Screen comes 
up on your analyzer’s LCD Screen. Initially, the first character of the month 
is highlighted in reverse video (white on black), as in the sample display 
shown here. To change a character, select the digit you want to replace the 
character with from the virtual numeric keypad displayed on the screen, 

Numeric 
keypad

Highlighted 
numeral
1-92 NITON XL3 Analyzer User’s Guide Thermo Scientific



The Rotate Screen 180 Toggle
then select the Enter (Ent) character from the virtual numeric keypad. Your 
analyzer will then accept the entry and automatically advance to the next 
digit. To skip a character, simply select the Enter (Ent) character from the 
virtual numeric keypad without selecting a replacement character. 

For example, on the sample display, if you wish to change the "06" of the 
month to "07", the display appears with the first character (0) highlighted. 
Select the Enter (Ent) character to skip the zero. The "6" will now be 
highlighted. Select the "7" digit from the virtual numeric keypad, then 
select the Enter (Ent) key from the virtual numeric keypad. The change is 
accepted and the next digit is highlighted. Continue to select the Enter 
(Ent) symbol from the virtual numeric keypad to skip over the remaining 
characters of the date and time until the last character is reached. When you 
select the Enter (Ent) key from the virtual numeric keypad to confirm the 
last character, the word "SUCCESS" will appear beneath the Time field, 
and you will be returned to the Main Menu. The date is given in 
month/day/year format.

Note The analyzer will automatically return you to the Main Menu when 
the entry is complete. �

The Rotate Screen 180
Toggle

Figure 1-33. The Rotate Screen 180 Menu Path

Select the Rotate Screen 180 icon to toggle the orientation of the screen 
between right side up and upside down.
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The Adjust Backlight Screen
The Adjust Backlight
Screen

Figure 1-34. The Adjust Backlight Menu Path

Select the Adjust Backlight icon to adjust the brightness of the analyzer 
screen.

Selecting the red [ - ] box will cause the slider to move some to the left and 
the screen to dim a bit. Selecting the green [ + ] box will cause the slider to 
move a bit to the right and the screen to brighten somewhat. Find the 
setting most harmonious with the ambient lighting. Selecting Close saves 
the backlight setting in the current state, and returns you to the Utility 
Menu. 
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The Hardware Setup Screen

The Hardware Setup
Screen

Figure 1-35. The Hardware Setup Menu Path

The Hardware Setup Screen enables you to toggle various options on or 
off, as well as select certain hardware dependant modes. Selecting an empty 
checkbox enables the option and places a check in the box. Selecting a 
checked box disables the option and clears the box.

Figure 1-36. Selecting Options

Select
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The Hardware Setup Screen
Select the Proximity Start checkbox to toggle the use of the front proximity 
button. This enables the proximity button to be used to start taking a 
sample on contact. Some nations have laws or regulations which prohibit 
use of this feature. In this case, the feature will be disabled before shipping.

Figure 1-37. Selecting Interlock Start

Select the Interlock Start checkbox to toggle the use of the rear interlock but-
ton. This requires the interlock button to be used to start taking a sample on
contact. Enabling the "Interlock Start" feature allows the user to start an anal-
ysis by depressing the rear interlock button on the analyzer.

Select
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The Hardware Setup Screen
Figure 1-38. Selecting Remote Trigger

Select the Remote Trigger checkbox to toggle the use of the Remote Trigger.
This is used when your XL3 is in a test stand or with the Extend-a-Pole. En-
abling the "Remote Trigger" feature allows you to start an analysis by remote
control.

Select
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The Hardware Setup Screen
Figure 1-39. Selecting Option Combinations for Multiple Effects

Select

Select
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The Hardware Setup Screen
.

Figure 1-40. Changing the Max Time Parameter

Select the numbers box in the Max Time field to change the maximum 
seconds per reading. A virtual numeric keypad will appear, allowing you to 
set the number to whatever value you want, up to the maximum of 36000. 
When the max testing time is reached during an analysis, the analyzer 
reading will be automatically ended. Your analyzer will continue switching 
filters as needed until you terminate the reading or the Max Time is reached.

Select

Virtual Numeric Keypad
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The Filter Config Screen
The Filter Config
Screen

Figure 1-41. The Filter Config Menu Path

Multi-Filter tests are used to either preferentially excite specific elements for 
increased sensitivity, or to cover a wider element range than one filter alone 
can provide. Most modes, when enabled, will use two filters in sequence to 
produce a combined analysis result. In typical alloy analysis applications, 
Mid Range is used for the analysis of most elements, and Low Range is 
utilized for the subsequent high sensitivity analysis of V, Ti, and Cr. 
Multi-filter switching can be set to activate off time alone, or, when time 
switching is disabled, off settings in the alloy grade library. In environmental 
modes, Low Range adds the capability to analyze light elements which 
cannot be efficiently excited by Mid Range.

.
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The Filter Config Screen
Figure 1-42. Selecting the Mode

Select the mode you wish to configure. You can set different configurations 
for different modes.

Select Mode
to Modify
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The Filter Config Screen
The Filter Config Screen enables you to directly enable or disable any 
filter, or control the time that a filter alters the irradiation of the sample 
before auto-switching to another filter.

Figure 1-43. The Filter Checkboxes

Select the checkbox next to the filter you want to use to determine exactly 
which of the filters contained in your NITON Analyzer is used for sample 
testing. Selecting an empty checkbox will enable that filter and place a check 
into the box as an indicator. Selecting a checked box will disable the filter 
and clear the box.

In typical alloy analysis applications, Mid Range is used for the analysis of 
most elements 

Low Range is utilized for the subsequent high sensitivity analysis of V, Ti, 
and Cr.

High Range is typically not used in alloy analysis.

Low Range 

checkbox

Mid-Range

checkbox
Filter

Filter 
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The Filter Config Screen
Figure 1-44. The Filter Switch on Time Only Checkbox

Select the Filter Switch on Time Only checkbox to toggle Time Switch 
Only Mode on or off. In Time Switch Only Mode, your NITON XL3 
analyzer will ignore the Alloy Library and only switch filters according to the 
time interval you set in the Time field for each filter.

Filter Switch
on Time Only 

checkbox
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The Filter Config Screen
Figure 1-45. The Filter Time Fields

Select the Time field for the intended filter to change the filter switch time 
for that Filter. The Filter Time Editor will appear. This enables you to set 
the number of seconds each enabled filter is allotted before auto-switching 
will occur when needed during sample testing. Your analyzer will 
auto-switch from one filter to another when the testing time for that filter is 
greater than or equal to the time you have chosen, and the identified alloy is 
flagged as needing the switch in the NITON Alloy Library.

Filter
Time Field
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The Filter Config Screen
Figure 1-46. The Filter Time Editor

Select the “C” key to clear the current time, then from the virtual numeric 
key pad, select each digit you want to input, then select “E” to enter.
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The Language Settings Screen
The Language
Settings Screen

Figure 1-47. The Language Settings Menu Path

Selecting the “Language Settings” icon will load the Language Screen, 
allowing you to change the language from the default English to French, 
Spanish, Portuguese, or German.

Figure 1-48. The Language Setting Screen
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The Language Settings Screen
Select the down-pointing triangle, and then select the language you want 
from the drop down menu. The Menu system will now show on screen in 
the language you have selected.

Figure 1-49. Selecting Language From the Drop Down Menu

Figure 1-50. The Main Menu in Chinese
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The Printer Setup Screen
The Printer Setup
Screen

Figure 1-51. The Printer Setup Menu Path

The Printer Setup Screen allows you to adjust which sections of your 
reading data are sent to your optional printer. By default, your analyzer 
prints the detected list, reading number, reading length, reading mode and 
any applicable measurement data such as Alloy match grade names. You can 
select any combination of options on the Printer Setup Screen to change 
what is printed.
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The Printer Setup Screen
Figure 1-52. The Printer Setup Screen

Print < LOD Selecting this option will enable printing of readings which are lower than 
the Limit of Detection.

Print Complete Selecting this option will enable printing of all the data fields in the reading.

Print Data Field Selecting this option will enable printing of all entered data fields.

Print Date & Time Selecting this option will enable printing of the Date and Time.
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The Beep Setup Menu
The Beep Setup Menu

Figure 1-53. The Beep Setup Menu Path

Selecting the Beep Times icon opens the Beep Setup Screen, enabling 
changes to the beep settings for various modes. The beeps sound as follows:

• First Beep - a single short beep.

• Second Beep - two beeps with different frequencies

• Third Beep - three beeps with alternating frequencies

• Grade Match Beep - two beeps of the same frequency.
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The Beep Setup Menu
Figure 1-54. The Beep Setup Screen

Mode This option allows you to change the beep settings for different modes 
independently. Select the down arrow to access the list of modes.

First Beep This option allows you to change the delay before the First Beep.

Second Beep This option allows you to change the delay before the Second Beep.

Third Beep This option allows you to change the delay before the Third Beep.

Beep on Grade Match Selecting this option will enable a special beep when the reading chemistry 
matches and alloy grade.
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The Sort Element Display Menu
The Sort Element
Display Menu

Figure 1-55. The Sort Element Display Menu Path

Select the Sort Element Display icon to configure sorting criteria used for 
analysis display. Selecting the Sort Element Display icon opens up the 
Sort Criteria Screen. Select the mode you wish to change, and the 
Sorting Options Screen will appear.
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The Sort Element Display Menu
Figure 1-56. The Sort Element Display

Figure 1-57. The Sorting Options Screen

Element affected

Current display option
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Top Arrow Button

Bottom Arrow Button

Scroll bar for elements

Display Options
Radio Buttons

Save Button

Close Button

(Move up in rank)

(Move down in rank)
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The Sort Element Display Menu
On the left of the display are elements, each with its currently selected 
display option beside it to the right. The element list is ranked by 
importance, with the most important element on top, and each one lower 
down of less importance than the one above it.

By selecting an element and using the arrow buttons to the right of the list, 
you can change its ranking. Use the Top Arrow Button to move an element 
one rank closer to the top with each click. Use the Bottom Arrow Button to 
move an element one rank closer to the bottom with each click.

.

Figure 1-58. Changed Sort Order

The Display Options Radio Buttons allow you to change the display status 
of any element to one of three states:

• Normal - The standard state. Element displays only when the elemental 
value is greater than the limit of detection.

• Always - Always display the results for this element. Use this state for 
elements critical to all of your analyses.

• Never - Never display the results for this element. Use this state for 
elements which are unimportant to your work. This makes your 
instrument display less complex.
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The Sort Element Display Menu
Select the element you want to change, then select the radio button 
corresponding to your choice of display status. The currently selected 
element is displayed in white on black.

Figure 1-59. Changed Display Options

Select the Save Button to save your current status as the new default. After 
saving, you will go back to the Element Display Menu.

Select the Close Button to exit without saving. When you select the Close 
Button after changing the display state of any element, a screen will open 
asking you if you want to save the changes you made. Selecting “Yes” will 
save these changes as the new default. Selecting “No” will return you to the 
Element Display Menu without saving the changes.
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The Sort Element Display Menu
Figure 1-60. Save Changes
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The Set Element Threshold Menu
The Set Element
Threshold Menu

Figure 1-61. The Set Element Threshold Menu Path

Select the Set Element Threshold icon to configure pass and fail criteria 
for elemental analysis. Selecting the Set Element Threshold icon opens 
the Set Threshold Screen. 

Figure 1-62. Set Threshold Screen
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The Set Element Threshold Menu
Select the mode you wish to work with from the scrollable list. This will 
open up the  Settings Screen for that mode.

Figure 1-63. Min/Max Settings Screen

Selecting the Min Value will open up the Min Editor for the selected 
element. 

Figure 1-64. The Min Editor

Mode

Save Button

Close Button

Element

Max Value

Min Value
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The Set Element Threshold Menu
The  Editor is very similar to the Logon Screen. The “C” button clears the 
field, and the “<“ button clears the last numeral. Select the numerals you 
want, then press “E” to enter the number. “OFF” resets the value to “OFF”

Selecting the Max  Value will open up the Max Editor for the selected 
element. 

Figure 1-65. The Max Editor

The Max Editor works the same as the Min Editor. 

When you press the “E” button in either editor, you are returned to the 
Min/Max Settings Screen, with your new values in place.

Selecting the “OFF” button not only sets the value to “OFF” but also saves 
the new value.
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The Set Element Threshold Menu
Figure 1-66. The Settings Screen with new parameters

Select the Save Button to save your current status as the new default. After 
saving, you will go back to the Element Display Menu. 

Select the Close Button to exit without saving. When you select the Close 
Button after changing the display state of any element, a screen will open 
asking you if you want to save the changes you made. Selecting “Yes” will 
save these changes as the new default. Selecting “No” will return you to the 
Element Display Menu without saving the changes.

Figure 1-67. Save Changes Screen
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The Adjust Alloy Thresholds Menu
The Adjust Alloy
Thresholds Menu

Figure 1-68. The Adjust Alloy Thresholds Menu Path

Select the Adjust Alloy Threshold icon to configure pass and fail criteria 
for alloy analysis. Selecting the Adjust Alloy Threshold icon opens the 
Alloy Threshold Screen.

Cutoff numbers set the allowable limits in identifications of analyzed 
samples. The higher the cutoff is set, the easier a match can be made in the 
Alloy Analysis, Signature ID, and SuperChem modes.

Figure 1-69. The Alloy Threshold Screen

Alloy 
Number 
Field
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The Adjust Alloy Thresholds Menu
Figure 1-70. The Alloy Match Threshold Screen
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The Set Display Units Menu
The Set Display Units
Menu

Figure 1-71. The Set Display Units Menu Path

Select the Set Display Units icon to choose between ppm (parts per 
million) and percentage (hundredths of whole) displays when taking 
readings, and to change the Sigma value you want for the reading. Selecting 
the Set Display Units icon opens the Set Display Units Screen.
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The Set Display Units Menu
Figure 1-72. Display Units Screen and Associated Results Screens

The Display Units Screen The Display Units Screen allows you to select either PPM or Percentage 
display on the Results Screen for Alloy, Mining, Plastic, Precious 
Metal, or Soil Modes. Select the radio button for the preferred display 
unit, then select the Save button, and subsequent results will be shown in 
that unit type. 

Note Readings will retain the unit type used when the reading was taken, 
even if the units are changed. �
1-124 NITON XL3 Analyzer User’s Guide Thermo Scientific



Changing Sigma
Changing Sigma

Sigma Sigma is the symbol used for Standard Deviation, a measure of how much a 
set of numbers deviates from the mean. For example, each of the three data 
sets {0, 0, 14, and 14}, {0, 6, 8, and 14} and {6, 6, 8, 8} has a mean of 7. 
Their standard deviations are 7, 5, and 1, respectively. The third set has a 
much smaller standard deviation than the other two because its values are all 
close to 7. In a loose sense, the standard deviation tells us how far from the 
mean the data points tend to be.

The number of standard deviations between the process mean and the 
nearest specification limit is given in sigmas. As process standard deviation 
goes up, or the mean of the process moves away from the center of the 
tolerance, the sigma number goes down, because fewer standard deviations 
will then fit between the mean and the nearest specification limit.

Confidence Intervals Confidence intervals assume that the data are from an approximately 
normally distributed population - generally, sums of many independent, 
identically distributed random variables tend towards the normal 
distribution as a limit. Using this assumption, about 68 % of the values 
must be within 1 standard deviation of the mean, about 95 % of the values 
must be within two standard deviations, about 99.7 % must lie within 3 
standard deviations, and about 99.99% of the values must lie within 4 
standard deviations. 
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Changing Sigma
The greater the sigma value of the test, the more confident you can be that 
the sample is as it appears, but the more difficult and time consuming the 
testing must be to verify this. That's why it's important to use the most 
appropriate sigma value for the test. By adjusting the sigma value for each 
type of test, you can optimize the process for your needs.

Adjusting the Sigma
Values

The sigma values are listed in the column headed " -- ". The default value is 
2 sigma. You can change this value by selecting the down arrow next to the 
value, which opens up a drop-down menu from which you can select the 
desired sigma value by clicking on it.

When you have changed the sigma values to the appropriate number, select 
the Save button to save these settings for use. Select the Close button to 
return to the previous screen without saving any changes.
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Toy Mode
Toy Mode

Figure 1-73. The Toy Mode Settings Menu Path

Select the Toy Mode Settings icon to change from RoHS Mode to Toy 
Mode settings. Toy Mode is an alternative plastics analysis mode which 
replaces the RoHS procedure  with a separate Toy Mode procedure. In Toy 
Mode, any detected element with a PASS/FAIL setting will fail, and will not 
PASS any sample unless the measurement time is completed and no flagged 
elements are detected. 

.
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Toy Mode
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Chapter 2 Routine Maintenance 
Guidelines

Battery Pack and
Battery Charger

Each NITON Analyzer is shipped with two lithium ion battery packs. 
When fully charged, the battery pack provides approximately 6-8-12 hours 
of use, depending on duty cycle. 

Replacement battery packs (NITON part number 600-5640) may be 
ordered from NITON in the United States, toll free, at (800) 875-1578, or 
outside the United States, at +1-978-670-7460, or from your local 
Authorized NITON Analyzers Service Center.

Note Before beginning a test, be certain that the battery has sufficient 
charge. �

CAUTION Do not leave the battery pack connected to the charger for 
excessive periods of time. Overnight recharging is recommended. �

CAUTION Store the analyzer and the spare battery packs in a cool place, 
away from direct sunlight. �

Replacing The Battery
Pack

1. Slide back the catch on the bottom of your analyzer’s pistol grip 
and drop the battery out into your hand.

2. Place the old battery aside and slide the new battery up into the 
cavity in the bottom of the pistol grip. The battery is keyed, and 
will only indert fully one way. 

3. Slide the catch on the bottom of the battery forward to lock it in 
place.

4. Press in the battery housing latch.
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Routine Maintenance Guidelines
Battery Pack and Battery Charger
5. Slide out the battery pack out.

6. Fully insert the new battery pack, making sure that it seats 
properly.

7. Press in until the latch resets.

Figure 2-1. Location of the Battery Housing Latch

Recharging The Battery
Pack

Fully recharging a battery pack takes approximately 2 hours. 

1. Remove the battery pack from the analyzer.

2. Place the battery pack upside down into the charger. The battery 
pack is keyed, and will only fit into the charger fully one way. If 
your battery pack is resting on the back of the back of the 
charger rather than sliding all hte way to the bottom, remove the 
battery pack, turn it around, and re-insert it into the charger.

Battery housing latch
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Routine Maintenance Guidelines
Battery Pack and Battery Charger
3. The red light is on when the charger is plugged in. This is the 
power indicator light.

Figure 2-2. Power Indicator Light

4. The yellow light indicates that the battery pack is currently being 
charged..

Figure 2-3. Charging Light

5. The green light indicates that the battery pack has finished 
charging and is ready for use.

Power Indicator Light

Power Indicator Light

Charging Indicator Light

Power Indicator Light

Fully Charged Indicator Light
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Routine Maintenance Guidelines
Battery Pack and Battery Charger
6. If there is a fully seated battery pack in the charger and only the 
red light is on, there is a fault with the battery pack or charger.

Figure 2-4. Rear and Side views of Battery Pack showing key

Key Shoulder
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Routine Maintenance Guidelines
Battery Pack and Battery Charger
Figure 2-5. Battery Pack in the Charger

CAUTION Do not store battery packs or charger in direct sunlight. �

CAUTION Do not let the battery pack recharge for excessive periods of time. 
�
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Routine Maintenance Guidelines
Maintenance, Cleaning and Repairs
Maintenance,
Cleaning and Repairs

To ensure the reliability, durability, and performance of your NITON 
Analyzer, keep it clean—especially the transparent Kapton window covering 
the analysis window. Clean the Kapton window gently with a cotton swab. 
Clean the body of the analyzer with a soft cloth. Never use detergents, or 
solvents on your analyzer, or immerse your analyzer in water. If the Kapton 
window becomes frayed, ripped, or contaminated with metal particulates, 
replace it with a new window. Kapton windows (NITON P/N 187-095) 
may be ordered from Thermo Fisher Scientific’s Service Department in the 
United States, toll free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460 or from your local Authorized NITON Analyzers Service 
Center.

From time to time, your touch screen will need cleaning. NITON 
recommends that you use a lens cleaning solution with a soft cloth. Do not 
use water to clean your NITON Analyzer.   

WARNING! All Service, except exterior cleaning and Kapton window 
replacement, must be performed by Thermo Scientific or an Authorized 
NITON Analyzers Service Center. Do not attempt to make repairs yourself. 
Opening the case of your NITON will void the analyzer Warranty in its 
entirety. �

CAUTION Always obtain a Return Authorization (RA) number from 
Thermo Fisher Scientific’s Service Department in the United States, toll 
free, at (800) 875-1578, or outside the United States, at +1-978-670-7460 
before returning your analyzer to the NITON Service Department or local 
Authorized NITON Analyzers Service Center. �
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Routine Maintenance Guidelines
Replacing the Kapton Window
Replacing the Kapton
Window

1. Remove the two Phillips head screws.

Figure 2-6. View of Face Plate and Kapton Window

2. Remove the face plate and place it face down. 

Figure 2-7. Face Plate Removed showing Kapton Window on Reverse

3. Remove the old Kapton window. 

4. Clean the back surface of the face plate and install the new 
Window.
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Routine Maintenance Guidelines
Replacing the Kapton Window
5. Turn the face plate over and replace it on the analyzer's front 
end, fitting the plate carefully over the Proximity Button.

Figure 2-8. Fitting Face Plate over Proximity Button

6. Reinstall the two screws, being careful not to over-tighten them.

Figure 2-9. Replacing the Screws.
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Routine Maintenance Guidelines
Storing and Transporting Your XL3 Analyzer
Storing and
Transporting Your XL3

Analyzer

All NITON Analyzers are transported in waterproof, drop-resistant, fully 
padded carrying cases with padlocks. In most countries, NITON XRF 
analyzers may be transported by car or plane or shipped as an ordinary 
package. For most courier services, no special labels are required on the 
outside of the NITON analyzer case or on additional packaging.

Figure 2-10. The NITON Carrying Case

All padlocks are shipped with a default combination of “0-0-0”. If you 
change this combination, please inform Thermo of the new combination if 
you return the unit for service.

To change the combination: 

1. Dial the default combination to open the lock, and pull out the 
shackle. 

2. Rotate the shackle 180 degrees and push it down as far as it can 
go. 

3. While holding the shackle down, rotate it 90 degrees back in 
either direction and release shackle. 

Padlock Locations
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Routine Maintenance Guidelines
Storing and Transporting Your XL3 Analyzer
4. Change the dial settings to the desired combination, record the 
combination, and without disturbing the dials, rotate the shackle 
back 90 degrees to the position it had in step 2.

5. Pull shackle out and rotate it 180 degrees and secure it. Your lock 
now has its own secret combination. 

CAUTION Always transport the unit in its padded carrying case, and store 
the NITON Analyzer in its case whenever it is not being used. �

CAUTION In most cases, no notification is required if transporting within 
state boundaries. This may not be the case when entering federal properties. 
�

CAUTION Within the United States, always keep a copy of the US DOT 
compliance statement in your NITON analyzer case at all times. A copy is 
included with your analyzer. �

CAUTION Always follow all pertinent local and national regulations and 
guidelines, wherever your analyzer is transported or used. �

CAUTION Always obtain a Return Authorization (RA) number from 
Thermo Fisher Scientific’s Service Department in the United States, toll 
free, at (800) 875-1578, or outside the United States, at +1-978-670-7460 
before returning your analyzer to the Service Department or to your local 
Authorized NITON Analyzers Service Center. �

CAUTION If you return your NITON analyzer without the carrying case, 
you will void your warranty in its entirety. You will be billed for a 
replacement case plus any repairs resulting from improper shipping. �

CAUTION Always remove the battery pack when transporting or storing 
your analyzer. �
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Networking and
Connectivity

Setting up Wireless
Networking

Figure 2-11. Wireless Networking Menu Path

Bluetooth Wireless Networking enables you to connect to your computer 
and other Bluetooth-enabled devices such as printers and GPS devices 
without the need of cabling, ports, or hubs.
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Networking and Connectivity
Available Devices Screen

Select the List Available Devices icon to show a list of Bluetooth devices 
previously discovered. The Bluetooth devices listed are only those which 
were present at the last time you ran a discovery scan for Bluetooth devices, 
as the list is not automatically updated. Selecting the List Available Devices 
icon brings up the Available Devices screen. From the list, you can connect 
your analyzer to those devices.
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Networking and Connectivity
Figure 2-12. Available Devices Screen

Under “Devices,” in the Device List Box, the Available Devices Screen lists 
all known applicable Bluetooth devices in the area found during the last 
refresh or scan. 

Figure 2-13. Example Device List

Device List Box

Connect Button

Refresh Button

Close Button
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Networking and Connectivity
• Selecting the Refresh Button initiates a scan of the area for new 
Bluetooth devices. Devices no longer present are removed.

Figure 2-14. Available Device Refresh

• Selecting a listed Bluetooth Device enables the Connect Button.

• Selecting the Connect Button will connect your analyzer to the selected 
device. See the Connected Screen.
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Networking and Connectivity
Bluetooth Search Screen

Select the Scan For Devices icon bring up the Bluetooth Search Screen, 
enabling you to initiate a discovery scan of Bluetooth devices in the 
operational area. This scan will find all appropriate Bluetooth devices in the 
operational area, enabling you to connect to those devices. 
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Networking and Connectivity
Figure 2-15. Bluetooth Search Screen

The Bluetooth Search Screen does not retain information about previously 
detected Bluetooth Devices. Each time the Bluetooth Search Screen is 
opened, the Device List Box is empty. 

• Selecting the Search Button initiates a scan for Bluetooth Devices in the 
area.

Device List Box

Connect Button

Search Button

Close Button
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Networking and Connectivity
Figure 2-16. Example Search List

Depending on where and when the Search Scan is conducted, certain 
devices may or may not be detected. You can select a device and connect to 
that device in exactly the same manner as in the Available Devices Screen, 
once the search is finished.

Figure 2-17. Search List with New Device Found
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Networking and Connectivity
The Connected Screen

Figure 2-18. The Connected Screen

When you have connected your analyzer to a Bluetooth Device, you get the 
Connection Screen. The Connection Screen serves as a reminder of what 
needs to be done to use the connection. With simple devices like GPS 
devices, a notification that you are connected is given, and everything just 
works, but working with a PC is a bit more complex.

In order to use a Bluetooth Serial Connection with a PC, you need to know 
which COM port Bluetooth is connected through. To determine this, right 
click on the Bluetooth logo in your system tray on your PC. From the 
popup menu which appears, select Advanced Config., then select Local 
Services. 

Figure 2-19. Advanced Configuration selection on PC
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Networking and Connectivity
Figure 2-20. Bluetooth Service Listing on PC

In the Bluetooth Serial Port row, the COM port used by Bluetooth is 
identified. Use this port for any interactions between your analyzer and your 
computer, such as NDT or NDTr. 

Make sure that the Secure Connection setting for the Bluetooth Serial Port 
is set to “Not Required.” 

Figure 2-21. Selecting Bluetooth Serial Port on PC

To edit the setting, double click the row.’
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Networking and Connectivity
Figure 2-22. Changing the Bluetooth Secure Connection Checkbox on PC

Unselect the Secure Connections checkbox if it is already selected, then 
select the “OK” button.
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Networking and Connectivity
Bluetooth Status Screen

The Bluetooth Status Screen enables you to see at a glance if and how your 
analyzer is connected to your computer.

 

Figure 2-23. Example Bluetooth Status Screen
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Networking and Connectivity
Select the Bluetooth Status icon to view the current status of your Bluetooth 
connections on the Bluetooth Status Screen. The Bluetooth Status Screen 
will display your analyzer’s serial number, connection status, the transfer 
rate, and your analyzer’s address 

The Bluetooth Status Screen shows your analyzer’s identification label, its 
connection state, the speed of the communication port setting, your 
analyzer’s network address, and the COD. 

In Figure 2-23, the analyzer “XL3t 20” is not connected to any computer, 
was last in Slave state - i.e. the last connection was initiated by the computer 
and not by the analyzer, has a com port set to communicate at 115200 
baud, has the unique network (MAC) address of 00A0960CE598, and has a 
COD (Class Of Device) of 00000000.

The Close screen button will return you to the Wireless Setup Menu.

 

Figure 2-24. Second Example Bluetooth Status Screen

In another example, in Figure 2-24, the analyzer “XL3t 20” is connected to 
the computer JAMEEL_P, is currently in Master state - i.e. connection was 
initiated by the analyzer and not by the computer, has a com port set to 
communicate at 115200 baud, has the unique network (MAC) address of 
00A0960CE598, and has a COD (Class Of Device) of 00000000.
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Networking and Connectivity
Reset Bluetooth Device

Select the Reset Bluetooth Device icon to initiate an immediate reset of the 
Bluetooth Wireless Networking. Selecting the Reset Bluetooth Device icon 
will clear out old settings and data, as well as enabling you to switch between 
Bluetooth and standard serial cable. While resetting, your analyzer will show 
the following screen:

Figure 2-25. Bluetooth Reset Alert
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Networking and Connectivity
GPS Data Tracking Bluetooth equipped NITON XRF Analyzers are capable of communicating 
with GPS modules and saving GPS coordinates with every reading. Follow 
the Bluetooth connection instructions found in the Users Manual to scan 
for and connect to a Bluetooth enabled GPS device.

Once connected, the GPS unit sends out a number of signals that can be 
read. The analyzer will display the relevant information from the GPS after 
connection, as shown in Figure 2-26

As shown in Figure 2-27, these coordinates can be viewed in the Data screen 
in entry positions eight, nine, and ten. (Scroll down to reach these fields.) 
When the results are downloaded using the NDT software the GPS 
coordinates are also stored and downloaded in data entry fields eight, nine 
and ten.

Figure 2-26. Example of GPS Data

Example of GPS Data • 2:52:13 GMT - Greenwich Mean Time obtained from the GPS 
satellites.

• Lat: 3355.2607 -Latitude coordinate of current location. This 
should be read as:

• All digits to the right of the decimal point are seconds.

• First two digits to the left of the decimal point are minutes.
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Networking and Connectivity
• The next two or three digits to the left of the decimal point are 
degrees.

• Thus 3355.2607 is read 33 degrees 55 minutes 26.07 seconds.

• N/S: S - Compass direction of Latitude.

• Long: 15111.594 - Longitude coordinate of current location.

• All digits to the right of the decimal point are seconds.

• First two digits to the left of the decimal point are minutes.

• The next two or three digits to the left of the decimal point are 
degrees.

• Thus 15111.594 is read 151 degrees 11 minutes 59.4 seconds.

• W/E: E - Compass direction of Longitude.

• Altitude: 17 - Height above sea level in meters.

• Quality: 1 - Quality of signal strength. 

• Num Sat: 8 - Number of satellites signals being received by GPS. 
This number varies depending on your position, the current 
position of the satellites, and the signal strength.

Figure 2-27. GPS Data Integrated Into Reading Data
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Networking and Connectivity
GPS Options The communication system standard required for compatibility is 
NMEA0182 ver. 3.0, using GPGGA, GPGSA, GPRMC, and GPGSV 
formats. This type of GPS is most commonly used for motor and marine 
directional mapping systems.

Tested Units include: Copilot BTGPS3

http://www.alk.com/copilot/pocketpc.asp

RoyalTek Star111

http://www.royaltek.com/index.php/content/view/98/80/

IOGEAR Bluetooth GPS

http://www.iogear.com/main.php?loc=product&Item=GBGPS201W6

Note These GPS systems have an accuracy of about 10 meters.
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Entering Data with a Barcode reader
Entering Data with a
Barcode reader

You can also use Bluetooth barcode readers with your analyzer. Connect 
your reader to your analyzer in the usual way, see See Chapter  2 page 11 for 
details. Once the reader is connected, you can use it to input data into your 
analyzer.

• On the data entry screen, highlight the desired field. 
• While pressing the button on the Barcode Pencil, swipe the desired 

barcode. If the pencil successfully reads the barcode, it will beep. 
• The barcoded data will show up in the data field after the beep. There 

is a short delay while the information is being transmitted
• You may also use the Virtual Keyboard Screen to enter barcoded 

data.

You can replace, append or clear any field with a  custom barcode:

• R05TEXT replaces field 5 with the TEXT
• A05C – appends field 5 with the letter C
• C05 – clears field 5
• C00 – clears all fields
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Entering Data with a Barcode reader
Supported Barcode
Readers

At the time of publication, supported readers include:

• The Baracoda Barcode Pencil

The Baracoda Barcode Pencil supports these barcodes for use with 
the XL3 system.

• Code 96 
• Code 128/EAN 128 
• EAN13/UPCA 
• UPCE/EAN8 
• Code 39 
• Codabar 
• Interleaved 2 of 5 
• Standard 2 of 5
• Code 11 
• MSI RSS14
• RS Limited

Consult your Baracoda Pencil Users Manual for more information 
and information on successful barcoding.
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Entering Data with a Barcode reader
Setting Up and Using the
USB port

The USB port is the narrow inverted trapezoidal port on the back of your 
XL3 Analyzer. You can use this port, along with the supplied cable, to 
communicate with your analyzer. 

Figure 2-28. Location of Mini-USB port

Insert the smaller end of your USB cable into the Mini-USB port on the 
back of your XL3, and the larger end into any USB port on your computer.

When you turn your analyzer on after it is connected, or if you connect it 
while the analyzer is on, a "Found New Hardware" Wizard will open, as in 
Figure 2-29. 

Figure 2-29. Found New Hardware Wizard

Mini USB Port
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Note If, after installation, you plug your USB cable into a different USB 
port on your computer, you will get this Wizard again.

The Installation Wizard Place the installation CD in the drive, select "No, not this time" then select 
"Next."  The Wizard will now ask you what you want it to do, as in 
Figure 2-30. Select "Install the software automatically." 

Figure 2-30. Wizard Choice

The Wizard will now search the CD for the proper software, as in 
Figure 2-31. When the Hardware Installation window comes up stating that 
the software has not passed XP logo certification, don't worry. The driver is 
from Microsoft. Select "Continue Anyway."

Figure 2-31. Installation Wizard Search
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The Wizard will now install the software. This may take several minutes. At 
the end of this process, you will see the final Wizard screen, as in 
Figure 2-32, informing you the process is complete. Select "Finish."

Figure 2-32. Final Installation Wizard Screen

The driver will install as the next free COM device - for example, if you 
have devices installed as COM1 through COM 5, the driver will install as 
COM 6. You can find how the software has been installed by clicking your 
START button, selecting Settings, and selecting Control Panel - as in 
Figure 2-33.

Figure 2-33. The Control Panel
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From the Control Panel,  double click on System. The System control panel 
will appear. "Select the "Hardware" tab. The window will appear as in 
Figure 2-34. Select "Device Manager."

Figure 2-34. The Hardware Screen

The device will appear under "Ports" in the Device Manager - select the plus 
sign in the box to display all the assigned ports. The device will be called 
"Thermo Scientific, NITON Analyzers USB Port."  After the name, the 
port number will be displayed in parentheses - in Figure 2-35, the device is 
assigned to COM 6. Use this port to connect to your analyzer. 

Figure 2-35. The Device Manager

Select

Installed USB Port
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Chapter 3 Radiation and General Safety

This chapter covers topics related to radiation safety and general safety when 
using a Thermo Scientific NITON XL3t analyzer. At a minimum all 
operators of the XL3t should be familiar with the instructions provided in 
this chapter in order to handle the XL3t in a safe manner. In addition to 
reading the information presented on the following pages, Thermo Fisher 
Scientific recommends that instrument users participate in a radiation safety 
and operational training class. 

WARNING! Always treat radiation with respect. Do not hold your analyzer 
near the Kapton window during testing. Never point your analyzer at 
yourself or anyone else when the shutter is open. �

Radiation and
General Safety

This chapter covers topics related to radiation safety and general safety when 
using a Thermo Scientific NITON XL3t analyzer. At a minimum all 
operators of the XL3t should be familiar with the instructions provided in 
this chapter in order to handle the XL3t in a safe manner. In addition to 
reading the information presented on the following pages, Thermo Fisher 
Scientific recommends that instrument users participate in a radiation safety 
and operational training class. 

Radiation Protection
Basics

The NITON Model XL3t analyzer contains an x-ray tube which emits 
radiation only when the user turns the x-ray tube on. When the x-ray tube is 
on and the shutter is open, as during a measurement, the analyzer emits a 
directed radiation beam (See Figures 0-6 and 0-7). Reasonable effort should 
be made to maintain exposures to radiation as far below dose limits as is 
practical. This is known as the ALARA (As Low as Reasonably Achievable) 
principle. For any given source of radiation, three factors will help minimize 
your radiation exposure: Time, Distance, and Shielding.

Time The longer you are exposed to a source of radiation the longer the radiation 
is able to interact in your body and the greater the dose you receive. Dose 
increases in direct proportion to length of exposure. 
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Radiation Protection Basics
Distance The closer you are to a source of radiation, the more radiation strikes you. 
Based on geometry alone, dose increases and decreases with an 
inverse-squared relation to your distance from the source of radiation 
(additional dose rate reduction comes from air attenuation). For example, 
the radiation dose one foot from a source is nine times greater than the dose 
three feet from the source. Remember to keep your hands and all body parts 
away from the front end of the analyzer when the shutter is open to 
minimize your exposure. 

Shielding Shielding is any material that is placed between you and the radiation 
source. The more material between you and the source, or the denser the 
material, the less you will be exposed to that radiation. Supplied or optional 
test stands are an additional source of shielding for analysis. A backscatter 
shield accessory is also available and may be appropriate in some 
applications. 

Exposure to Radiation Human dose to radiation is typically measured in rem, or in 
one-thousandths of a rem, called millirem (mrem), 1 rem = 1000 mrem.   
Another unit of dose is the Sievert (Sv), 1 Sv = 100 rem. The allowable limit 
for occupational exposure in the U.S (and many countries internationally) is 
5,000 mrem/year (50 mSv/year) for deep (penetrating) dose and 50,000 
mrem/year (500 mSv/year) for shallow (i.e., skin) dose or dose to 
extremities. Deep, shallow, and extremity exposure from a properly used 
NITON XL3t analyzer should be less than 200 mrem per year, (2.0 mSv per 
year) even if the analyzer is used as much as 2,000 hours per year, with the 
shutter open continuously. The only anticipated exceptions to the 200 
mrem maximum annual dose are: 1) routine and frequent analysis of plastic 
samples without use of a test stand, backscatter shield, or similar additional 
protective measures, or 2) improper use where a part of the body is in the 
primary beam path. NEVER OPERATE THE DEVICE WITH A PART 
OF YOUR BODY IN THE PRIMARY BEAM PATH OR WITH THE 
PRIMARY BEAM PATH DIRECTED AT ANYONE ELSE. Also, 
consider the use of protective accessories such as a shielded test stand or 
backscatter shield (or equivalent) when performing routine and/or frequent 
analysis of any of the following: 

• plastic (or similarly low density) samples, 

• thin samples (such as foils, circuit boards, and wires), or 

• samples that are smaller than the analysis window. 

Shown in Table 3-1 below are the typical background radiation doses 
received by the average member of the public. The radiation dose limits for 
radiation workers in the US are also shown in Table 3-2. 
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Radiation Protection Basics
Table 3-1. Typical Radiation Doses Received (Source: NCRP 1987)

Category Dose in mrem Dose in mSv 

Average total dose in US (annual) 360 3.6 

Average worker exposure (annual) 210 2.1 

Average exposure for an underground miner 400 4.0 

Exposure for airline crew (1,000 hours at 35,000 
ft) 

500 5.0 

Additional from living in Denver at 5300’ 
(annual) 

25 .25 

Additional from 4 pCi/l radon in home 1,000 10.0 

Typical Chest X-Ray 6 0.06 

Typical Head or Neck X-Ray 20 0.2 

Typical pelvis/hip x-ray 65 0.65 

Typical lumbar spine x-ray 30 0.3 

Typical Upper G.I. x-ray 245 2.45 

Typical Barium enema x-ray 405 4.05 

Typical CAT scan 110 1.10 

Table 3-2. Annual Occupational Dose Limits for Radiation Workers 
(Source: Code of Federal regulations Title 10, Part 20)

Category Dose in mrem Dose in mSv 

Whole Body 5000 50 

Pregnant Worker (during gestation period) 500 5 

Eye Dose Equivalent 15,000 150 

Shallow dose equivalent to the skin or any 
extremity or organ 

50,000 500 

Maximum allowable dose for the general 
public (annual) 

100 1.0 

For a Minor 500 5.0 
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Radiation Protection Basics
Monitoring your radiation
exposure

Individuals can be monitored for the radiation dose they receive by use of 
radiation dosimetry devices (dosimeters). Monitoring dose using a 
dosimeter can be a way of identifying improper use and at the same time 
demonstrating proper use. In some locations, dosimetry is required by 
regulations and in others it is optional. It is normally required when the user 
could reasonably be expected to receive in excess of 10% of the annual dose 
limit. Thermo Fisher Scientific recommends that you determine and obey 
the local regulatory requirements concerning radiation monitoring of 
occupational workers. 

Two common types of dosimeters are whole-body badges and ring badges. 
Whole body badges are often attached to the user’s torso (e.g., clipped to the 
collar, shirt pocket, or waist as appropriate). A ring badge is worn on the 
finger as a measure of maximum extremity dose. When worn, the specific 
location of the dosimeter should be that part of the body that is expected to 
receive the highest dose. This location will depend on how the analyzer is 
used and so it may not be the same for all users. Dosimetry services are 
offered by many companies. Two companies offering dosimetry services in 
the USA and much of the world are: 

Global Dosimetry Solutions 

2652 McGaw Avenue 

Irvine, CA 92614 

www.dosimetry.com 

(800) 251-3331 

Landauer, Inc. 

2 Science Road 

Glenwood, IL 60425-9979

www.landauerinc.com 

(800) 323-8830 

Note Wearing a dosimeter badge does not protect you against radiation 
exposure. A dosimeter badge only measures your exposure (at the dosimeter 
location). �
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Radiation Protection Basics
Pregnancy and Radiation
Exposure

International guidance documents (e.g., ICRP Publication 60 and NCRP 
Publication 116*) recommend that the radiation dose to the embryo/fetus 
of a pregnant woman should not exceed a total of 500 mrem (10% of 
normal radiation worker limit) during the gestation period. While this dose 
limit exceeds the dose limit to a trained operator, pregnant workers may 
want to take special precautions to reduce their exposure to radiation. For 
more information see the U.S. NRC Regulatory Guide 8.13 "Instruction 
Concerning Prenatal Radiation Exposure" which can be found on the 
resource CD.   

* The International Commission on Radiological Protection, ICRP, is an 
independent Registered Charity, established to advance for the public 
benefit the science of radiological protection, in particular by providing 
recommendations and guidance on all aspects of protection against ionizing 
radiation. 

* The National Council on Radiation Protection and Measurements 
(NCRP) was chartered by the U.S. Congress in 1964 as the National 
Council on Radiation Protection and Measurements. 
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How to Use the NITON XL3t Analyzer Safely
How to Use the
NITON XL3t Analyzer

Safely

The NITON XL3t analyzer is designed to be safe to operate provided that it 
is used in accordance with manufacturers’ instructions. Under conditions of 
normal use, monitored operators seldom receive a measurable dose and have 
not been known to receive in excess of 10% of the annual occupational dose 
limits (a criteria that would require monitoring under regulation in the 
U.S.). In addition to proper use of the XL3t, it is recommended that you 
follow these precautions to ensure your safety and the safety of those around 
you.   

Know where the beam is The primary beam is a directed beam out of the front of the analyzer that 
can have high dose rates. The secondary beam, or scattered beam, has much 
lower dose rates. 

Figure 3-1. . Primary Beam
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How to Use the NITON XL3t Analyzer Safely
Figure 3-2. Secondary (Scattered) Beam

The Shutter-Open
Indicator Lights

When the lights are flashing, the primary beam is on, the shutter is open, 
and radiation is being emitted from the front of the analyzer. (This does not 
include the brief flash of the lights when first turning the analyzer on.) 
Thermo Scientific NITON XL3 Analyzer User’s Guide 3-7



Radiation and General Safety
How to Use the NITON XL3t Analyzer Safely
Figure 3-3. X-ray BeamThe Shutter Open Indicator Lights

Handle and Use with
Respect

Avoid holding the front of the analyzer when the x-ray tube is energized and 
the shutter is open. Never point the instrument at yourself or anyone else 
when the shutter is open and the x-ray tube is energized. Never look into the 
path of the primary beam. 

Follow a Radiation
Protection Program

Your organization should establish, document, and follow a Radiation 
Protection Program. An example of such a program can be found on the 
resource CD (provided with the instrument). 

Take Proper Care of your
NITON XL3t Analyzer

Keeping your analyzer maintained in good condition will help minimize the 
risk of accidental exposure. Mechanical malfunction of the shutter can be 
avoided by maintaining the Kapton window, as described in the User Guide. 
This prevents foreign objects from entering your XL3t.

Avoid Over-Exposures Direct contact with the window could result in overexposures in the times 
indicated in Table 0-4 below.
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Safe Handling of Samples
Extremity is defined by the NRC as the hand, elbow, arm below the elbow, foot, knee, or leg below
the knee. Whole Body is defined by the NRC as the head, trunk (including male gonads), arms
above the elbow, or legs above the knee.

Safe Handling of
Samples

As mentioned many times in this chapter, never place any part of your body 
in the path of the x-ray beam. There is always a safe way to handle samples 
whether they are small, irregularly shaped, or of low density. Never look into 
the path of the primary beam. 

Small Samples A small sample would be any sample that is smaller than the Kapton 
window. Small samples present a unique risk because they don’t block the 
entire beam path. The difficulty with placing small samples down on a work 
surface to analyze them is that you may get readings from the work surface 
that interfere with analytical results. A test stand is an effective way of 
analyzing small samples accurately and safely. Never hold samples during 
analysis or look into the path of the primary beam. 

Irregularly Shaped Samples Irregularly shaped samples may not allow the proximity button to be 
depressed, or they may not entirely cover the primary beam and cause 
additional scattering. A back scatter shield is a safe way of reducing your 
radiation exposure while effectively analyzing an irregularly shaped sample. 

Low Density Materials (such as
plastics)

X-rays are attenuated more through denser materials and less through low 
density materials such as plastic. This causes higher dose rates in the 
scattered radiation. If you are frequently handling low density samples, you 
should consider the use of test stands, backscatter shields, or the equivalent. 

Table 3-3. Potential Exposure Limit Times

Location of Dose  Limit  Time to Reach Limit

Deep Dose / Whole 
Body

 5 rem (50 mSv)  2.1 minutes

Shallow Dose / 
Extremities

 50 rem (500 mSv)  0.95 minutes

Member of Public 
(i.e. untrained 
operator)

 0.1 to 5 rem (1 to 50 mSv)  2.5 to 9.5 seconds
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Radiation Profile
Radiation Profile Table 3-4, Table 3-5, Table 3-6 and Table 3-7 below describes the external 
radiation dose rates that are present at various points in space around the 
NITON XL3t analyzer when it is being used. Figure 3-4 illustrates where 
these dose rate points are relative to the analyzer.  

* G = Alloy, B = Alloy Electronics, F = Dental Alloy, P = Precious Metals, M = Mining, D = Soil, 

J = Exploration, A = Lead Paint, E = Thin Sample, H = Plastic

Table 3-4. Primary Beam Dose Rates in mSv/hr

Max Power 
Settings

Max Power 
Settings

Window 
Contact 
Deep

Window 
Contact
Shallow

5 cm
Deep

30 cm
Deep

kVp µA Max in Following 
Modes* (Filter)

(mSv/hr) (mSv/hr) (mSv/hr) (mSv/hr)

40 50 G, D, E, A, P, F, M, J 
(Main Filter)

1,410 1,410 50.00 6.3

40 50 B (Main Filter) 750 2,250 40.00 5.4

50 40 H (Main Filter), D, E, 
M, J (High Filter)

1,090 4,060 84.0 12.2

20 100 D, H, E, M, J (Low 
Filter)

1,450 31,717 5.2 0.5

15 100 A, B (Low Filter) 133 10,567 4.3 0.42

Table 3-5. Primary Beam Dose Rates in Rem/hr

Max Power 
Settings

Max Power 
Settings

Window 
Contact 
Deep

Window 
Contact
Shallow

5 cm
Deep

30 cm
Deep

kVp µA Max in Following 
Modes* (Filter)

(Rem/hr) (Rem/hr) (Rem/hr) (Rem/hr)

40 50 G, D, E, A, P, F, M, J 
(Main Filter)

141 141 5.00 0.63

40 50 B (Main Filter) 75 2,25 4.00 0.54

50 40 H (Main Filter), D, E, 
M, J (High Filter)

109 406 8.4 1.22

20 100 D, H, E, M, J (Low 
Filter)

145 3,171.7 0.52 0.05

15 100 A, B (Low Filter) 13.3 1,056.7 0.43 0.042
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Radiation Profile
* G = Alloy, B = Alloy Electronics, F = Dental Alloy, P = Precious Metals, M = Mining, D = Soil,

J = Exploration, A = Lead Paint, E = Thin Sample, H = Plastic.

Table 3-6. Secondary (Scatter) Dose Rates (µSv/hr)

kVp µA Max in Following Modes* 
(Filter)

Substrate Max @ 5cm 
(µSv/hr)
Point A

Max @ 30 cm 
(µSv/hr)
Point A’

Max @ Trigger 
(µSv/hr)
Point B

40 50 G, D, E, A, P, F, M, J (Main Filter) Aluminum 25 2 0.5

40 50 G, D, E, A, P, F, M, J (Main Filter) Stainless 16 1.2 0.1

40 50 B (Main Filter) Aluminum 4 0.4 0.1

40 50 B (Main Filter) Stainless 1.4 0.1 0.1

50 40 H (Main Filter), D, E, M, J (High 
Filter)

Plastic 400 35 20

50 40 H (Main Filter), D, E, M, J (High 
Filter)

Soil 80 4 0.7

20 100 D, H, E, M, J (Low Filter) Aluminum 0.15 0.1 0.1

20 100 D, H, E, M, J (Low Filter) Stainless 0.15 0.1 0.1

20 100 D, H, E, M, J (Low Filter) Plastic 1.3 0.15 0.15

20 100 D, H, E, M, J (Low Filter) Soil 0.15 0.15 0.15

15 100 A, B (Low Filter) Aluminum 0.15 0.15 0.15

15 100 A, B (Low Filter) Stainless 0.15 0.15 0.15
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Radiation Profile
* G = Alloy, B = Alloy Electronics, F = Dental Alloy, P = Precious Metals, M = Mining, D = Soil,

J = Exploration, A = Lead Paint, E = Thin Sample, H = Plastic.

Table 3-7. Secondary (Scatter) Dose Rates (mRem/hr)

kVp uA Max in Following Modes* 
(Filter)

Substrate Max @ 5cm 
(mRem/hr)
Point A

Max @ 30 cm 
(mRem/hr)
Point A’

Max @ Trigger 
(mRem/hr)
Point B

40 50 G, D, E, H, A, P, F, M, J (Main 
Filter)

Aluminum 2.5 0.2 0.05

40 50 G, D, E, H, A, P, F, M, J (Main 
Filter)

Stainless 1.6 0.12 0.01

40 50 B (Main Filter) Aluminum 0.4 0.04 0.01

40 50 B (Main Filter) Stainless 0.14 0.01 0.01

50 40 H (Main Filter), D, E, M, S, J 
(High Filter)

Plastic 40 3.5 2

50 40 H (Main Filter), D, E, M, S, J 
(High Filter)

Soil 8 0.4 0.7

20 100 D, H, E, M, S, J (Low Filter) Aluminum 0.015 0.01 0.01

20 100 D, H, E, M, S, J (Low Filter) Stainless 0.015 0.01 0.01

20 100 D, H, E, M, S, J (Low Filter) Plastic 0.13 0.015 0.015

20 100 D, H, E, M, S, J (Low Filter) Soil 0.015 0.015 0.015

15 100 A, B (Low Filter) Aluminum 0.015 0.015 0.015

15 100 A, B (Low Filter) Stainless 0.015 0.015 0.015
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Figure 3-4. Primary & Secondary Dose Rate Locations

Primary Radiation Primary radiation is radiation that is produced by the analyzer and emitted 
out through the kapton measurement window. Individuals should never 
place any part of their body in the primary beam path when the x-ray tube is 
on. There should always be a sample in contact with the measurement 
window when the x-ray tube is on. The sample will absorb most of the 
primary-beam radiation unless it is smaller than the instrument's 
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measurement window or of low density and/or thickness. Caution should be 
taken when analyzing samples that are small, thin, and/or low in density as 
they may allow much more of the primary beam to escape. In-beam primary 
radiation dose rates are listed in Table 3-4 and Table 3-5 and their location 
identified relative to the analyzer in Figure 3-4 as Dose Point C.   

Secondary Radiation Under conditions of normal and proper use, individuals can be exposed to 
secondary (or "scattered") radiation. Secondary radiation is low-level 
radiation that emanates from the sample being analyzed as a result of 
primary beam radiation scattering in the sample or primary beam radiation 
inducing fluorescent x-rays in the sample. Dose points A, A’ and B in 
Figure 3-4 are examples of where you can encounter secondary radiation. 
The magnitude of this secondary radiation is sample dependent. Higher 
density samples such as steel will emit the lowest levels as they absorb most 
primary and secondary radiations. Lower density samples such as 
aluminum, wood, and especially plastic, will produce higher levels of 
secondary radiation. Secondary radiation dose rates are listed in Table 3-6 
and Table 3-7 for a few common sample types over a wide range of 
densities. 

The operator is reminded that one should never hold samples during 
analysis, doing so will result in higher than necessary exposure to secondary 
radiation and could expose the operator directly to the much higher 
primary-beam dose rates. 

Deep and Shallow Dose You will find in Table 3-4 and Table 3-5 that shallow dose rates are listed for 
some dose points. All dose rates listed in Table 3-4 and Table 3-5 are deep 
dose unless they are specifically identified as shallow dose. Deep dose is dose 
from penetrating radiation that is delivered to both skin and underlying 
tissues and organs and is the type most commonly referred to when 
describing external radiation hazards. Occupational deep dose is limited to a 
maximum of 5 rem (50 mSv) per year in the United States and most 
countries internationally. Deep dose is measured at 1.0 cm below the skin 
surface.

Shallow dose is often referred to as "skin dose" because it is a result of 
low penetrating radiation that only interacts with the skin. Shallow dose 
is limited to a maximum of 50 rem (500 mSv) per year in the United 
States and most countries internationally. Shallow dose is listed below for 
primary in-beam dose points only because the low penetrating radiation 
that causes shallow dose is nearly all absorbed by a sample and does not 
produce any significant secondary radiation. Shallow dose is measured at 
a point 0.007 cm below the surface.
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Storage & Transportation
Storage &
Transportation

Storage Regulations in nearly all locations will require that you store your analyzer 
locked in a secured area to prevent access, use, and/or removal by 
unauthorized individuals. Storage requirements will vary by location, 
particularly with regard to storage at temporary job sites or away from your 
primary storage location such as hotels and motels and in vehicles.  You 
should contact your local Radiation Control Authority to identify the 
specific storage requirements in your jurisdiction. 

Transportation There are no specific US Department of Transportation (DOT) or 
International Air Transport Association (IATA) radiation regulations 
regarding shipping the NITON XL3t analyzer. It is recommended that you 
ship the XL3t in its carrying case and an over-pack to protect the sensitive 
measuring equipment inside the analyzer. 

Do NOT ship the analyzer with the battery pack connected to the analyzer. 
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EMERGENCY PROCEDURES
EMERGENCY
PROCEDURES

THIS PAGE CONTAINS EMERGENCY CONTACT INFORMATION 
THAT SHOULD BE AVAILABLE TO THE OPERATOR AT ALL 
TIMES. 

Lost or Stolen Instrument If the NITON XL3t analyzer is lost or stolen, notify your Radiation Safety 
Officer (RSO) or the equivalent responsible individual at your company or 
institution immediately. Your company's RSO, as well as other important 
emergency contacts, are listed below. Your company RSO may need to 
notify the x-ray tube regulatory authority and the local police. It is also 
recommended that a notification is made to Thermo Fisher Scientific. 

Damaged Instrument

Minor Damage If the instrument is intact but there is indication of an unsafe condition such 
as a cracked case, a shutter mechanism failure, or the lights remain flashing 
after a measurement is terminated, follow these steps: 

1. Stop using the instrument 

2. Remove the battery, the x-ray tube can not produce radiation 
when the battery is disconnected. The instrument is now safe to 
handle. 

3. Place the instrument securely in the holster   

4. Place the instrument in the carrying case that came with the 
instrument.   

5. Notify your Radiation Safety Officer (RSO) or the equivalent 
responsible individual at your company or institution 
immediately.   

6. You or your RSO should call Thermo Fisher Scientific at one of 
their contact numbers listed below for additional instructions 
and guidance.   
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EMERGENCY PROCEDURES
Major damage If the instrument is severely damaged: 

1. Perform the same steps as described above for minor damage. 
There will be no radiation hazard as long as the battery is 
removed from the instrument.   

2. Place all components in a plastic bag and contact Thermo Fisher 
Scientific. 

Emergency Response
Information

Please Complete the Following Emergency Response Information and Keep 
with the Analyzer at All Times

NITON ANALYZER EMERGENCY CONTACT INFORMATION

The Company RSO is:______________________________________

RSO Telephone Number:____________________________________

Regulatory Agency Emergency Number:________________________

Local Fire Department:______________________________________

Local or State Police Department:_____________________________

Thermo Fisher Scientific's NITON Analyzer Contact Numbers

Main Number (USA): (800) 875-1578

Service (USA): (401) 294-1234

Additional Radiation Emergency #'s: (978) 790-8269 or (617) 901-3125

Outside the USA - Local NITON Service Center:___________________

For assistance with your NITON XL3t analyzer outside the United States, 
please contact your nearest manufacturer's service center identified below:

Europe NITON Analyzers Europe
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EMERGENCY PROCEDURES
Munich, Germany

Phone: +49 89 3681 380

Fax: +49 89 3681 3830

Email: niton.eur@thermo.com

Asia NITON Analyzers Asia 

Hong Kong 

Phone: +852 2869-6669 

Fax: +852 2869-6665 

Email: niton.asia@thermo.com 
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Registration and Licensing
Registration and
Licensing

As a user of a NITON XL3t analyzer, you may be required to register or 
obtain a license with your local radiation control authority. In the US, if you 
intend to do work with your XL3t in states other than your own, you may 
be required to register there as well. Below is a list of commonly asked 
questions that come up when filling out registration forms. 

FAQ What is the max mA, max kVp, and max power? 

Maximum mA is 0.1 mA 

Maximum kVp is 50 kVp 

Maximum power: 2 watts 

 

What is the accelerator voltage or MeV? 

This should be filled out as not applicable N/A as it does not apply to XL3t 
analyzers. 

 

What is the radioisotope? 

There are no radioactive isotopes in XL3t analyzers. 

 

What category is the XL3t? 

States differ greatly in their categories; the following is a list of common 
categories: 

o X-Ray Fluorescence 

o Analytical or Analytical XRF 

o Open Beam or Open Beam Analytical 

o Portable Gauge or Portable XRF 

o Industrial Analytical or Non-Destructive Testing 
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When selecting the category make sure that you don't select medical or 
radiographic. 

 

How many tubes are in the XL3t? 

One. 

 

What is the analyzer serial number? 

The serial number is a 5 digit number located on the yellow sticker on the 
underside of your analyzer. 

 

What is the tube serial number? 

The serial number on the tube is different from the serial number on the 
analyzer itself. If your jurisdiction asks for this number please call us at 
1-800-875-1578 and ask to speak with someone regarding X-Ray tube 
registrations and we can look this number up for you. 

 

What is the type of X-Ray Processing? 

None. XL3t analyzers do not use film. 

 

How often do I need to perform leak tests on the XL3t? 

Never. Leak tests are only required for analyzers with radioactive isotopes. 
XL3t analyzers do not have radioactive isotopes. 

Regarding Safety Devices
for the Open Beam

Configuration:

In the US, you may be required to file for an exemption, "variance letter", 
with your state if there is a requirement for a safety device that would 
prevent entry of an extremity into the primary beam. If you need assistance 
with the exemption letter, you may contact the radiation safety group. 
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Contact Information
Contact Information If you have additional questions, please feel free to contact the Radiation 
Safety Group. If you have questions about regulatory requirements, we 
recommend that you contact your local radiation control authority. Contact 
information is listed below. 

Thermo Fisher Scientific Contact Information 

 

Radiation Safety Group By phone: +1 978-670-7460 

 By fax: +1 978-670-7430 

 By e-mail: Radsafety.Billerica@thermofisher.com 

Radiation Emergency Numbers (Call only if there is a radiation emergency)

Phone: +1 617-901-3125

Phone: +1 978-790-8269

Service Departments USA (Rhode Island) Phone:+1 401-294-1234 

Fax: +1 401-295-2090 

Germany Phone:+49 89 368138-0 

Fax:+49 89 368138-30 

Hong Kong Phone:+852 2869-6669 

Fax:+852 2869-6665 

United States Regulatory
Authority Contact

Information

A list of states and their contacts can be found at the following website:

http://www.hsrd.ornl.gov/nrc/asdirectr.htm 
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Contact Information
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Appendices

Appendix A: X-ray Emission Energies Arranged by Element, by Increasing Atomic 
Number, in KeV

Table A-1. X-ray Emission Energies Arranged by Element, by Increasing Atomic Number, in KeV

Element Symbol Atomic 
Number

Atomic 
Weight

Ka1 Kb1 La1 Lb1 Lg1

potassium K 19 39.10 3.3 3.6

calcium Ca 20 40.08 3.7 4.0

scandium Sc 21 44.96 4.1 4.5

titanium Ti 22 47.87 4.5 4.9

vanadium V 23 50.94 4.9 5.4

chromium Cr 24 52.00 5.4 5.9

manganese Mn 25 54.94 5.9 6.5

iron Fe 26 55.85 6.4 7.1

cobalt Co 27 58.93 6.9 7.6

nickel Ni 28 58.69 7.5 8.3

copper Cu 29 63.55 8.0 8.9

zinc Zn 30 65.41 8.6 9.6

gallium Ga 31 69.72 9.2 10.3

germanium Ge 32 72.64 9.9 11.0

arsenic As 33 74.92 10.5 11.7

selenium Se 34 78.96 11.2 12.5

bromine Br 35 79.90 11.9 13.3

krypton Kr 36 83.80 12.6 14.1

rubidium Rb 37 85.47 13.4 15.0

strontium Sr 38 87.62 14.2 15.8

yttrium Y 39 88.91 15.0 16.7

zirconium Zr 40 91.22 15.8 17.7

niobium Nb 41 92.91 16.6 18.6

molybdenum Mo 42 95.94 17.5 19.6

technetium Tc 43 98.00 18.4 20.6 2.4 2.5 2.8

ruthenium Ru 44 101.07 19.3 21.7 2.6 2.6 3.0
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rhodium Rh 45 102.91 20.2 22.7 2.7 2.8 3.1

palladium Pd 46 106.42 21.2 23.8 2.8 3.0 3.3

silver Ag 47 107.87 22.2 25.0 3.0 3.2 3.5

cadmium Cd 48 112.41 23.2 26.1 3.1 3.3 3.7

indium In 49 114.82 24.2 27.3 3.3 3.5 3.9

Tin Sn 50 118.71 25.3 28.5 3.4 3.7 4.1

antimony Sb 51 121.76 26.4 29.7 3.6 3.8 4.3

tellurium Te 52 127.60 27.5 31.0 3.8 4.0 4.6

iodine I 53 126.90 28.6 32.3 3.9 4.2 4.8

xenon Xe 54 131.29 29.8 33.6 4.1 4.4 5.0

cesium Cs 55 132.91 31.0 35.0 4.3 4.6 5.3

barium Ba 56 137.33 32.2 36.4 4.5 4.8 5.5

lanthanum La 57 138.91 33.4 37.8 4.7 5.0 5.8

cerium Ce 58 140.12 34.7 39.3 4.8 5.3 6.0

praseodymium Pr 59 140.91 36.0 40.7 5.0 5.5 6.3

neodymium Nd 60 144.24 37.4 42.3 5.2 5.7 6.6

promethium Pm 61 145.00 38.6 44.0 5.4 6.0 6.9

samarium Sm 62 150.36 40.1 45.4 5.6 6.2 7.2

europium Eu 63 151.96 41.5 47.0 5.8 6.5 7.5

gadolinium Gd 64 157.25 43.0 48.7 6.1 6.7 7.8

terbium Tb 65 158.92 44.5 50.4 6.3 7.0 8.1

dysproium Dy 66 162.50 46.0 52.2 6.5 7.3 8.4

holmium Ho 67 164.93 47.5 53.9 6.7 7.5 8.7

erbium Er 68 167.26 49.1 55.7 6.9 7.8 9.1

thulium Tm 69 168.93 50.7 57.6 7.2 8.1 9.4

ytterbium Yb 70 173.04 52.4 59.4 7.4 8.4 9.8

lutetium Lu 71 174.97 54.1 61.3 7.7 8.7 10.1

hafnium Hf 72 178.49 55.8 63.2 7.9 9.0 10.5

tantalum Ta 73 180.95 57.5 65.2 8.1 9.3 10.9

tungsten W 74 183.84 59.3 67.2 8.4 9.7 11.3

rhenium Re 75 186.20 61.1 69.3 8.7 10.0 11.7

osmium Os 76 190.23 63.0 71.4 8.9 10.4 12.1

iridium Ir 77 192.22 64.9 73.6 9.2 10.7 12.5

Table A-1. X-ray Emission Energies Arranged by Element, by Increasing Atomic Number, in KeV

Element Symbol Atomic 
Number

Atomic 
Weight

Ka1 Kb1 La1 Lb1 Lg1
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platinum Pt 78 195.09 66.8 75.7 9.4 11.1 12.9

gold Au 79 196.97 68.8 78.0 9.7 11.4 13.4

mercury Hg 80 200.59 70.8 80.3 10.0 11.8 13.8

thallium Tl 81 204.38 72.9 82.6 10.3 12.2 14.3

lead Pb 82 207.20 75.0 85.9 10.5 12.6 14.8

bismuth Bi 83 208.98 77.1 87.3 10.8 13.0 15.2

polonium Po 84  (209.0) 79.3 89.8 11.1 13.4 15.7

astatine At 85  (210.0) 81.5 92.3 11.4 13.9 16.2

radon Rn 86  (222.0) 11.7 14.3 16.8

francium Fr 87  (223.0) 12.0 14.8 17.3

radium Ra 88  (226.0) 12.3 15.2 17.8

actinium Ac 89  (227.0) 12.7 15.7 18.4

thorium Th 90 232.04 13.0 16.2 19.0

protactinium Pa 91 (231.0) 13.3 16.7 19.6

uranium U 92 238.03 13.6 17.2 20.2

neptunium Np 93 237.00 13.9 17.7 20.8

plutonium Pu 94 244.00 14.3 18.3 21.4

Table A-1. X-ray Emission Energies Arranged by Element, by Increasing Atomic Number, in KeV

Element Symbol Atomic 
Number

Atomic 
Weight

Ka1 Kb1 La1 Lb1 Lg1
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Appendix B: X-ray Emission Energies Arranged Alphabetically by Element, by name
Table A-2. X-ray Emission Energies Arranged Alphabetically by Element, by name

Element Symbol Atomic 
Number

Atomic 
Weight

Ka1 Kb1 La1 Lb1 Lg1

actinium Ac 89  (227.0) 12.7 15.7 18.4

antimony Sb 51 121.76 26.4 29.7 3.6 3.8 4.3

arsenic As 33 74.92 10.5 11.7

astatine At 85  (210.0) 81.5 92.3 11.4 13.9 16.2

barium Ba 56 137.33 32.2 36.4 4.5 4.8 5.5

bismuth Bi 83 208.98 77.1 87.3 10.8 13.0 15.2

bromine Br 35 79.90 11.9 13.3

cadmium Cd 48 112.41 23.2 26.1 3.1 3.3 3.7

calcium Ca 20 40.08 3.7 4.0

cerium Ce 58 140.12 34.7 39.3 4.8 5.3 6.0

cesium Cs 55 132.91 31.0 35.0 4.3 4.6 5.3

chromium Cr 24 52.00 5.4 5.9

cobalt Co 27 58.93 6.9 7.6

copper Cu 29 63.55 8.0 8.9

dysproium Dy 66 162.50 46.0 52.2 6.5 7.3 8.4

erbium Er 68 167.26 49.1 55.7 6.9 7.8 9.1

europium Eu 63 151.96 41.5 47.0 5.8 6.5 7.5

francium Fr 87  (223.0) 12.0 14.8 17.3

gadolinium Gd 64 157.25 43.0 48.7 6.1 6.7 7.8

gallium Ga 31 69.72 9.2 10.3

germanium Ge 32 72.64 9.9 11.0

gold Au 79 196.97 68.8 78.0 9.7 11.4 13.4

hafnium Hf 72 178.49 55.8 63.2 7.9 9.0 10.5

holmium Ho 67 164.93 47.5 53.9 6.7 7.5 8.7

indium In 49 114.82 24.2 27.3 3.3 3.5 3.9

iodine I 53 126.90 28.6 32.3 3.9 4.2 4.8

iridium Ir 77 192.22 64.9 73.6 9.2 10.7 12.5

iron Fe 26 55.85 6.4 7.1

krypton Kr 36 83.80 12.6 14.1

lanthanum La 57 138.91 33.4 37.8 4.7 5.0 5.8

lead Pb 82 207.20 75.0 85.9 10.5 12.6 14.8

lutetium Lu 71 174.97 54.1 61.3 7.7 8.7 10.1
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manganese Mn 25 54.94 5.9 6.5

mercury Hg 80 200.59 70.8 80.3 10.0 11.8 13.8

molybdenum Mo 42 95.94 17.5 19.6

neodymium Nd 60 144.24 37.4 42.3 5.2 5.7 6.6

nickel Ni 28 58.69 7.5 8.3

niobium Nb 41 92.91 16.6 18.6

osmium Os 76 190.23 63.0 71.4 8.9 10.4 12.1

palladium Pd 46 106.42 21.2 23.8 2.8 3.0 3.3

platinum Pt 78 195.09 66.8 75.7 9.4 11.1 12.9

polonium Po 84  (209.0) 79.3 89.8 11.1 13.4 15.7

potassium K 19 39.10 3.3 3.6

praseodymium Pr 59 140.91 36.0 40.7 5.0 5.5 6.3

promethium Pm 61 145.00 38.6 44.0 5.4 6.0 6.9

protactinium Pa 91 (231.0) 13.3 16.7 19.6

radium Ra 88  (226.0) 12.3 15.2 17.8

radon Rn 86  (222.0) 11.7 14.3 16.8

rhenium Re 75 186.20 61.1 69.3 8.7 10.0 11.7

rhodium Rh 45 102.91 20.2 22.7 2.7 2.8 3.1

rubidium Rb 37 85.47 13.4 15.0

ruthenium Ru 44 101.07 19.3 21.7 2.6 2.6 3.0

samarium Sm 62 150.36 40.1 45.4 5.6 6.2 7.2

scandium Sc 21 44.96 4.1 4.5

selenium Se 34 78.96 11.2 12.5

silver Ag 47 107.87 22.2 25.0 3.0 3.2 3.5

strontium Sr 38 87.62 14.2 15.8

tantalum Ta 73 180.95 57.5 65.2 8.1 9.3 10.9

technetium Tc 43 98.00 18.4 20.6 2.4 2.5 2.8

tellurium Te 52 127.60 27.5 31.0 3.8 4.0 4.6

terbium Tb 65 158.92 44.5 50.4 6.3 7.0 8.1

thallium Tl 81 204.38 72.9 82.6 10.3 12.2 14.3

thorium Th 90 232.04 13.0 16.2 19.0

thulium Tm 69 168.93 50.7 57.6 7.2 8.1 9.4

Tin Sn 50 118.71 25.3 28.5 3.4 3.7 4.1

Table A-2. X-ray Emission Energies Arranged Alphabetically by Element, by name

Element Symbol Atomic 
Number

Atomic 
Weight

Ka1 Kb1 La1 Lb1 Lg1
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titanium Ti 22 47.87 4.5 4.9

tungsten W 74 183.84 59.3 67.2 8.4 9.7 11.3

uranium U 92 238.03 13.6 17.2 20.2

vanadium V 23 50.94 4.9 5.4

xenon Xe 54 131.29 29.8 33.6 4.1 4.4 5.0

ytterbium Yb 70 173.04 52.4 59.4 7.4 8.4 9.8

yttrium Y 39 88.91 15.0 16.7

zinc Zn 30 65.41 8.6 9.6

zirconium Zr 40 91.22 15.8 17.7

Table A-2. X-ray Emission Energies Arranged Alphabetically by Element, by name

Element Symbol Atomic 
Number

Atomic 
Weight

Ka1 Kb1 La1 Lb1 Lg1
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Appendix C: SpectraView

SpectraView enables you to qualitatively analyze the fluorescent x-rays of 
most of the elements in the periodic table. For a complete list of elements 
and their fluorescent x-rays see Appendix A. In SpectraView Mode, the 
spectrum is displayed in a linear scale, autoscaled logarithmically so that the 
highest peak on the screen reaches the top of the scale.

How to Use SpectraView You can access the SpectraView screen after taking a measurement in any 
mode, or while viewing a previous measurement, by selecting Spectra from 
the NAV Menu. Once you are in SpectraView, you can use the up and down 
positions of the 4-way touch pad to scroll through the spectrum, or you can 
tap on the spectrum display with the stylus to place the cursor at the point 
you tapped. The vertical cursor line indicates the current position along the 
spectrum.

Viewing the Information in
SpectraView Mode

Figure A-1. The SpectraView Screen

By default, the following information is shown along with the spectrum:

The Reading number (Bottom Left) in the form "Read:x", where x is the 
Reading number.

Energy at 

NAV Menu

Vertical Slider

Spectrum Peaks

Reading Number

Horizontal Slider

Nearest Peaks
Count Rate

Cursor Position
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The position of the cursor on the energy scale (Bottom Left, under the 
Reading number), in the form "E: x.xx KeV", where KeV is thousands of 
electron volts.

The count rate (Bottom Left, under the energy position), in the form 
“R:x.xx”.

Ka, Kb, La, Lb, and/or Lg peaks of the three elements closest to where 
your cursor is positioned on the energy scale (Bottom Right). This 
information is written with the element symbol first, followed by either Ka 
(K shell alpha peak), Kb (K shell beta peak), La (L shell alpha peak), La (L 
shell beta peak), or Lg (L shell gamma peak). An example would be "Al Ka 
1.5." To determine if a given element is present, look at the count rate at 
that cursor position. 

SpectraView cannot be used to determine exact element percentages in a 
sample.

Multiple Spectra SpectraView can display the reading spectra from multiple sources if your 
analyzer has more than one X-ray source or filter. Use the NAV Menu to 
select which spectrum to view.

The “Spectra1” choice will display the display the spectrum produced by 
excitation from the first source tube setting.

The “Spectra2” choice will display the display the spectrum produced by 
excitation from the second source tube setting.

The “Spectra3” choice will display the display the spectrum produced by 
excitation from the third source tube setting.

SpectraView Navigation Use the left button on the 4-way touch pad to expand the spectrum, 
centered on the position of the cursor.

Use the right button on the 4-way touch pad to contract the spectrum, 
centered on the position of the cursor.
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Figure A-2. Viewing Multiple Spectra

Select NAV to access the
NAV Menu while viewing the
first source spectrum.

Select Spectra2 to view
the second source spectrum

Select NAV to access the
NAV Menu.

Select Spectra1 to return to 
the first source spectrum.
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Appendix D: Summary of Warnings

WARNING! Do not attempt to use this instrument without first reading and 
understanding the entire User’s Guide! �

WARNING! Always treat radiation with respect. Do not hold your 
instrument near the Kapton window during testing. Never point your 
instrument at yourself or anyone else when the shutter is open. �

WARNING! Do not attempt to take measurements while downloading 
readings! This will generate an error requiring a system reset, and may 
corrupt your stored readings, requiring all stored readings to be erased. �

WARNING! All Service, except exterior cleaning and Kapton window 
replacement, must be performed by Thermo Scientific. Do not attempt to 
make repairs yourself. Opening the case of your NITON will void the 
instrument Warranty in its entirety. �

WARNING! The preconditions for operation must be continued for the 
duration of the reading. If the preconditions are violated, the x-ray tube will 
turn off, the calibration shutter will close, and the measurement will end. 
The four LED lights will stop blinking when the measurement is ended. 
The flashing of the LED lights is not synchronized to minimize power 
consumption. �

WARNING! In the highly unlikely event that the x-ray tube remains on 
when the trigger is not depressed, disconnect the battery pack immediately 
to turn off the x-ray tube, and call Thermo Scientific’s Service Department 
in the United States, toll free, at (800) 875-1578, or outside the United 
States at +1-978-670-7460, or your local Authorized NITON Analyzers 
Service Center. �

WARNING! When all four LED lights are blinking, the x-ray tube is on. 
This should only occur during a measurement, while the preconditions for 
operation are met. On startup, the front pair of lights will blink. If the LED 
lights blink at any other time, disconnect the battery pack and call Thermo 
Scientific’s Service Department in the United States, toll free, at (800) 
875-1578, or outside the United States, at +1-978-670-7460, or your local 
Authorized NITON Analyzer Service Center. �
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WARNING! Thickness correction is only for use with plastic/polymer 
samples. �
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Appendix E: Summary of Cautions

CAUTION Never turn off the instrument while data is being erased! �

CAUTION Whenever you turn on your NITON XL3 Alloy and Plastics 
Analyzer after it has been off for more than 30 minutes, you should measure 
your check sample to assure proper operation. If the instrument is not 
reading properly, you should re-calibrate your NITON XL3 Analyzer's 
sample analysis electronics before you start to take readings. When the 
instrument is turned on after being off for more than 30 minutes, your 
NITON analyzer will require a 10 minute warm-up period before the 
instrument can be calibrated, unless this 10 minute warm-up period is 
manually overridden.

CAUTION Do not leave the battery pack connected to the charger for 
excessive periods of time. Overnight recharging is recommended. �

CAUTION Store the instrument and the spare battery packs in a cool place, 
away from direct sunlight. �

CAUTION Always transport the unit in its padded carrying case, and store 
the NITON Analyzer in its case whenever it is not being used. �

CAUTION Do not let the battery pack recharge for excessive periods of time. 
�

CAUTION In most cases, no notification is required if transporting within 
state boundaries. This may not be the case when entering federal properties. 
�

CAUTION Do not store battery packs or charger in direct sunlight. �

CAUTION Always follow all pertinent local and national regulations and 
guidelines, wherever your XL3 analyzer is transported or used. �

CAUTION Always obtain a Return Authorization (RA) number from 
Thermo Scientific’s Service Department in the United States, toll free, at 
(800) 875-1578, or outside the United States, at +1-978-670-7460 before 
returning your instrument to the Service Department or to your local 
Authorized NITON Analyzers Service Center. �
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CAUTION If you return your NITON instrument without the carrying case, 
you will void your NITON Analyzer's warranty in its entirety. You will be 
billed for a replacement case plus any repairs resulting from improper 
shipping. �

CAUTION Always remove the battery pack when transporting or storing 
your instrument. �

CAUTION Avoid any vibration, loud noise, strong electronice fields, or other 
possible interference when your analyzer is calibrating its detector. �

CAUTION NITON Analyzers are not intrinsically safe analyzers in regard to 
sparking. All pertinent Hot Work procedures should be followed in areas of 
concern. �

CAUTION When teaching your analyzer a new alloy signature in Match 
Signature Mode, the measurement must be taken for at least a full 60 
nominal seconds, as displayed on your analyzer's touch screen display. �

CAUTION After being powered on, your NITONnalyzer will perform an 
internal re-calibration before an analysis is initiated. It is recommended that 
you let your analyzer warm up for ten minutes after start up, before testing is 
begun. �

CAUTION Within the United States, always keep a copy of the US DOT 
compliance statement in your NITON analyzer case at all times. A copy is 
included with your analyzer. �
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Appendix F: Warranty

Thermo Fisher Scientific will warranty parts and labor for any 
manufacturer’s defects for two years (24 months). No precision instrument 
is warranted if crushed, dropped on the floor or in a bucket of water. All 
service, including repairs and routine maintenance, and  x-ray tube 
replacement  or re-sourcing, must be performed by Thermo Fisher Scientific 
or by an Authorized NITON Analyzer Service Facility. Any attempt to open 
the sealed plastic housing of your NITON instrument will nullify the 
instrument warranty in its entirety. 

Limited Warranty Provision for
Use with Purchase and License

Agreement for Thermo Scientific
XRF Detection instruments:

Except as otherwise agreed in writing, Thermo Fisher Scientific warrants, 
under normal conditions of operation, each product sold (except for 
components not of its manufacture) against defects of material and 
workmanship, provided that such product has been properly utilized. This 
warranty applies to the original purchaser only and shall commence to run 
from the date of shipment and shall continue for a period of twenty-four 
(24) months. In any event, Thermo Fisher’s liability for any such defects of 
material and workmanship shall not exceed the cost of replacement of 
defective parts upon timely notification of such defect in writing delivered 
to Thermo Fisher’s home office. Thermo Fisher shall not be liable for 
damage or destruction caused during delivery or caused other than by 
employees of Thermo Fisher Scientific. 

Material, accessories, parts, or items of equipment furnished by suppliers to 
Thermo Fisher and used in the manufacture of Thermo Fisher products are 
guaranteed by Thermo Fisher Scientific only to the extent of the original 
manufacturer’s express warranty to Thermo Fisher for a period not to exceed 
the warranty period described in paragraph (a) above and provided that the 
purchaser shall have notified Thermo Fisher so as to enable Thermo Fisher 
to avail itself of its rights under such original manufacturer’s express 
warranty. 

Specific warranties of
some common

accessories:

• Battery Charger 12 months 
• Batteries 12 months 
• Soil Grinder no warranty 
• Single-stage helium tank regulator 12 months 
• Two-stage helium tank regulator 12 months 
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Thermo Fisher Scientific shall, at its option, repair such defects or replace 
the parts or products found defective. All defective parts are to be returned, 
freight prepaid, immediately to Thermo Fisher for inspection and credit. 
Thermo Fisher will make no allowance for repairs or alterations made by the 
purchaser unless made with the advance written consent of Thermo Fisher.

Thermo Fisher Scientific assumes no liability for costs of disassembly of 
defective parts and equipment. Shipment by purchaser of all repairs and 
replacements under this warranty are F.O.B. Thermo Fisher Scientific’s 
factory or authorized service representative and method of shipment will be 
determined by Thermo Fisher. The purchaser will pay shipping costs and 
insurance in both directions of products, parts, or components shipped for 
warranty service hereunder. The purchaser will be responsible for risk of loss 
in both direction. Replaced parts or components will become the property 
of Thermo Fisher Scientific. Replacement parts or components may contain 
recycled, refurbished, or remanufactured parts equivalent to new parts and 
shall be warranted for the remainder of the original warranty period for the 
products. 

Thermo Fisher Scientific shall not be liable for delays, deprivation of use, or 
any other damages, direct or indirect, which may result to the purchaser 
because of defects in the product or because of the purchaser’s inability to 
operate it or use it to his satisfaction. Thermo Fisher Scientific will not be 
liable to anyone for special or consequential damages of any kind. Thermo 
Fisher neither assumes nor authorizes any person to assume for it, any other 
obligation or liability with respect to Thermo Fisher products. 

Except for the foregoing express warranty, there are no warranties, 
representations, or guarantees, express or implied, except as are expressly set 
forth herein. The foregoing warranty is the only warranty made by Thermo 
Fisher Scientific. Any implied warranty of merchantability or fitness for a 
particular purpose on this product is limited in duration to the one year (12 
month) duration of this written warranty. Some countries, and some states 
within the United States, do not allow limitations on how long an implied 
warranty lasts or the exclusion of limitation of incidental or consequential 
damages so the above limitations or exclusions may not apply to you. This 
warranty gives you specific legal rights and you may also have other rights 
which vary from state to state and country to country. 
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A Aluminum Alloys, Analysis and Sorting of 1-43 
Analyzer, Carrying Case 2-9 
Analyzer, Storing and Transporting of 2-9 

B Battery Charger, description and use of 2-1 
Battery Life Indicator 0-ix 
Battery Pack, description and use of 2-1 
Battery Pack, recharging of 2-2 
Beep Setup 1-110 

C Calibrate Detector, method for 1-85 
Calibrate Touch Screen Screen 1-87 
COM device, installing USB port as 2-31 
conditions of normal use 3-6 
Control Panel, The, Description of 0-ii 

D Damaged Instrument, Notification process 3-16 
Data Entry Screen, Navigating 1-21, 1-53 
Data Entry Screen, The, methods of use 1-50 
Data-Entry, Plastics Mode 1-19 
Device Manager 2-32 
Display Units, Setting of 1-123, 1-127 

E Element Display Options 1-114 
Element Display, Sorting Options 1-113 
Element Thresholds, Setting of 1-117 
Elements, Sorting of 1-72 
Emergency Response Information 3-17 
Example Averaging 1-5 

F Filters, Mid Range 1-100, 1-102 
Function 

Erase All Data 1-75 
Erase Readings 1-76 
Erase Signatures 1-77 
Erase SuperChem 1-78 
Erase SuperPrec 1-79 
View Libraries 1-80 
View Signatures 1-81 
View SuperChem 1-82 
View SuperPrec 1-83 

Function, Avg Back, description of 1-3 
Function, Avg Forward, description of 1-2 
Function, Backlight, description of 1-2 
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Function, Print, description of 1-2 
Function, Stop Avg/Fwd Back, description of 1-4 

G GPS, Bluetooth, Tested Units 2-26 

H Handling of Samples 3-9 
Hardware Setup Screen, The, explaination and use of 1-95 

I Interlock Start, enabling and disabling 1-96, 1-97 

K Kapton Window, Replacing 2-7 

L LCD Touch Screen, closing 0-iv 
LCD Touch Screen, raising 0-iv 
LCD Touch Screen, The, description and use 0-iv 
Lost or Stolen Instrument, Notification Process 3-16 
Low Range 1-100, 1-102 

M Maintenance, Cleaning and Repairs 2-6 
Match Number, explaination of 1-57 
Max Time Parameter, setting of 1-99 
Menu Path, generic description of 0-x 
Methods of Operation, description of 1-15, 1-47 
Methods of Operation, List of 1-15 
Mode 

All Alloys 1-25, 1-63 
Cu/Zn/Pb Analysis 1-28 
Match Signature Analysis 1-31 
SuperChem Analysis 1-35 
SuperChem Teach 1-38 
Ta/Hf/Re Analysis 1-29 

N NAV Menu 0-viii 
NAV Menu, The, Applications, description of 1-1 
Networing, Bluetooth, Status Display 2-21 
Networking, Bluetooth, Available Devices Listing 2-12 
Networking, Bluetooth, Connecting to PCs 2-18 
Networking, Bluetooth, discovery scan 2-15 
Networking, Bluetooth, GPS Data Tracking 2-24 
Networking, Bluetooth, GPS Device Options 2-26 
Networking, Bluetooth, PC Services 2-19 
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Networking, Bluetooth, Refreshing Available Device List 2-14 
Networking, Bluetooth, Reseting Bluetooth Device 2-23 
Networking, Bluetooth, Searching for Available Devices 2-15 
Networking, Bluetooth, Serial Connection on PC 2-20 
Networking, Bluetooth, Serial Connection with PC, connecting 2-18 
Networking, Bluetooth, Service Listing on PC 2-19 
Networking, Bluetooth, Setting up 2-11 
Networking, Bluetooth, Slave state, explaination of 2-22 
Networking, Bluetooth, unselecting Secure Connections 2-20 

P Plastics Mode, Results Screen 1-17 
Prepared Samples, Testing of 1-18 
Printers, Setup of 1-108 

R Radiation Exposure, and Pregnancy 3-5 
Radiation Exposure, Monitoring 3-4 
Radiation Safety Group Contact Information 3-21 
Radiation, Exposure to 3-2 
Radiation, Open Beam Configuration 3-20 
Radiation, Primary 3-13 
Radiation, Secondary 3-14 
Results Screen, The, Alloy, example and description 1-56 
RoHS, Standard Operating Procedure 1-7 
RoHS, Testing Screen 1-7 
Rotate Screen 180 Toggle 1-93 

S Secondary (Scattered) Beam, area of 3-7 
Sort Element Display 1-112 
Source Switch on Time Only 1-103 
Specs Screen, The. Description of 1-91 
Spectrum Graph 1-73 
Startup, Instrument 0-vi 
Store Signature Screen, The 1-33 
SuperChem Teach - Inputting Composition 1-41 

T Thickness Correction, general overview 1-10 
Thickness Correction, How to apply 1-10 
Thickness Correction, When to use 1-11 
Tools Menu, The, description of 1-2 

U USB Installation Wizard 2-30 
USB port, installing 2-29 
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V Video, Camera and Small Spot 1-59 
Video, hash mark 1-60 
Video, Small Spot Technology, How to use 1-60 
View Data Screen, The, description and uses of 1-71 
Virtual Keyboard, The, description and use of 1-22, 1-54 
Virtual Numeric Keypad 0-vii 

X XL3, Registration and Licensing 3-19 
XL3, Storage 3-15 
XL3, Transportation 3-15 
XL3t, Radiation, Frequently Asked Questions 3-19 
X-ray Beam, position of 3-6 
X-ray, Emission Energies, Table A-1 A-1 
X-ray, Emission Energies, Table A-2 A-4 
X-ray, Indicator Lights 3-7 
X-ray, Radiation Profile 3-10 
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